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Introduction
This guide provides an overview of Siebel Search, MidMarket Edition, and it is 
written from an employee and customer perspective. The primary focus of this 
guide is to provide configuration and administration instructions to allow you to set 
up Siebel Search on your Siebel application. 

NOTE: All Siebel MidMarket product names include the phrase MidMarket Edition 
to distinguish this product from other Siebel eBusiness Applications. However, in 
the interest of brevity, after the first mention of a MidMarket product in this 
document, the product name will be given in abbreviated form. For example, after 
Siebel Call Center, MidMarket Edition, has been mentioned once, it will be referred 
to simply as Siebel Call Center. Such reference to a product using an abbreviated 
form should be understood as a specific reference to the associated Siebel 
MidMarket Edition product, and not any other Siebel Systems offering. When 
contacting Siebel Systems for technical support, sales, or other issues, note the full 
name of the product to make sure it will be properly identified and handled.

This book will be useful primarily to people whose title or job description matches 
one of the following:

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing Computer Telephony 
Integration (CTI), SmartScripts, and message broadcasts.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
Version 7.5 Siebel Search Administration Guide MidMarket Edition 9



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide provides information necessary to implement, configure, and administer 
Siebel Search in your Siebel application. 

Read Chapter 1, “About Siebel Search,” for an overview of Siebel Search 
functionality, including a list of common search operators and connectives.

Read Chapter 2, “The User Experience,” for an overview of Siebel Search from the 
user’s point of view. 

Read Chapter 3, “Overview of Search Setup and Maintenance,” for a conceptual 
overview of setup and maintenance of Siebel Search. 

Read Chapter 4, “Installing Siebel Search Under Windows,” for instructions on 
setup of Siebel Search.

Read Chapter 5, “Siebel Search Configuration Using Siebel Tools,” for instructions 
on configuring Search for your Siebel application using Siebel Tools. 

Read Chapter 6, “Administration of Siebel Search,” for instructions on 
administering and maintaining your search indices.

Read Appendix A, “Siebel Search Environmental Variables,” for a list of 
environmental variables and search parameters.

Read Appendix B, “Troubleshooting,” for a list of common problems and 
troubleshooting solutions. 

Read Appendix C, “Syntax For Filter Search Specifications,” for a list of filter search 
specification syntaxes.
10 Siebel Search Administration Guide MidMarket Edition Version 7.5
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Revision History
Revision History
Siebel Search Administration Guide, MidMarket Edition, Version 7.5.
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About Siebel Search 1
Siebel Search is a text-retrieval tool that allows Siebel eBusiness Applications users 
to perform full-text searches across Siebel records and files found inside and outside 
the Siebel application structure. Users of the Search Center, an intuitive user 
interface, can perform complex searches from anywhere within their employee and 
partner Siebel eBusiness Application. Personalized visibility rules can be applied to 
search results so each user will only view search results to which they have been 
given access. Documents and database records found by the search can be 
previewed in the browser or launched in their native application.

NOTE: Certain Hummingbird products (Hummingbird Search Server) are included in 
the Siebel Search product. A license to these Hummingbird products is included 
with every license of the Siebel Search. Siebel eBusiness Applications use license 
key numbers to allow your organization to access the products you have licensed. 
We are providing you with license keys only for the software programs and 
documentation for which you have acquired a license, as set forth in your 
company’s license agreement with Siebel Systems, Inc. Software programs and 
documentation are Siebel “Confidential Information” and should be treated as such 
in accordance with applicable terms of your company’s license agreement with 
Siebel. The license keys for Hummingbird found in this guide have been generated 
for you. Your company’s license agreement with Siebel Systems, Inc. sets forth the 
permitted uses of these license keys, which include, but are not limited, to requiring 
that you use these license keys only in combination with Siebel Programs and not 
on a stand alone basis.
Version 7.5 Siebel Search Administration Guide MidMarket Edition 13



About Siebel Search

Search Retrieval Techniques
Search Retrieval Techniques
Search capabilities are included in every Siebel application license. These 
capabilities allow you to perform full text searches using basic Boolean operators. 
Boolean operators allow you to create a more precise query. See Table 1 on page 20 
for a list of search operators and connective terms.

Search Retrieval Type
Siebel Search supports basic Boolean settings. For more information on Search 
settings see “Search Execution Settings” on page 106. 

Boolean Operators
A search license allows you to perform searches using the strict Boolean retrieval 
model. The strict Boolean retrieval model offers very precise control over what is 
retrieved during a search. This model will exclude desired text that does not 
conform exactly to the search criteria. 

When searching for matching rows in a table or document, this model uses strict 
Boolean operations for combining search terms. There is no question of degree to 
which a match is found—all matches must be exact.

For example: Performing a search for “Computers” AND “Monitors” would make 
sure that only documents or database records containing both words would be 
retrieved. 

For a list of Boolean operators see “Search Operators and Connectives” on page 20.
14 Siebel Search Administration Guide MidMarket Edition Version 7.5



About Siebel Search

Search Retrieval Techniques
Search Techniques
Siebel Search supports a variety of search techniques. These techniques allow you 
to refine your search operations. For more information on setting up and 
administering basic Siebel Search default techniques see “Search Execution 
Settings” on page 106. 

Single Term Searches
This search technique allows you to enter a single keyword and receive results 
based on that term.

For example: If you enter the word “computer,” results which contain the word 
computer will be returned. 

Multiple Terms Searches
This search technique allows you to enter two or more keywords with spaces. Here 
the default Search Term Separator is assumed to be OR. 

For example: If you enter the text “computer windows server,” it will translate, 
when you run the search, as “computer OR windows OR server”. The returned 
results will include records that contain one of more of these terms. This differs 
from the operator AND, in that, the separator AND makes sure that records returned 
will contain all search terms. 

For a list of multiple term search terms see “Search Query Examples” on page 22.

For information on how to change or set the default search term separator see 
“Search Execution Settings” on page 106.

Phrase Searches
This search technique allows you to conduct a search for records where a chosen 
phrase is contained. 

For example: If you enter the phrase “computer science” (quotes included) records 
containing the word computer followed by a space, then the word “science” will be 
returned. 
Version 7.5 Siebel Search Administration Guide MidMarket Edition 15



About Siebel Search

Search Retrieval Techniques
Wildcard Searches
This search technique allows you to find pages containing words similar to a given 
word. You use the wildcard character either to represent a single character, or an 
optional sequence of characters.

For example: If you enter “comput*”, the search will return words that have the 
same prefix “comput”, such as “computer,” “computing,” and so on.

For a list of wildcard symbols see “Search Query Examples” on page 22.

Special Character Searches
This search technique allows you to use special characters other than those 
provided by wildcard searches. 

For example: If you search for the word “on?line” the search would return matches 
to online, on;line, on.line, on line, on-line, and so on.

For a list of special characters see “Search Operators and Connectives” on page 20.
16 Siebel Search Administration Guide MidMarket Edition Version 7.5



The User Experience 2
This chapter describes the similarities and differences in using Siebel Search in an 
employee or partner application and in a customer application.
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The User Experience

The Search Center User Experience
The Search Center User Experience
Employee or partner users of Siebel Search will have an experience that differs from 
the experience of customers. Those differences begin with the Search Center. 

The Search Center is a central location where users can perform searches and 
queries on database records and documents. The query entry values are persistent 
when the results are presented to allow users to understand what has been queried 
upon and to refine and return to their query even after closing the search center 
window. Users can perform queries against database records from anywhere in their 
Siebel application.

The Search Center frame is opened by clicking on the binocular icon and can be 
invoked from anywhere in the Siebel application. There is a hide button, as well as 
a close button. Closing the Search Center window returns users to the full view of 
the screen. 

Siebel Search User Experience in Customer Applications
Siebel Search for customer applications can be accessed globally in the application 
from the toolbar. There are two ways in which a user can perform a search. The 
user may enter a full-text query in the Search box, or the user may click the 
Advanced Search link, and perform a search against single or multiple categories.
18 Siebel Search Administration Guide MidMarket Edition Version 7.5



The User Experience

Common End-User Tasks
Common End-User Tasks
Tasks commonly performed in Siebel Search are listed below. For information on 
administering listed search settings see “Administration of Siebel Search” on 
page 93.

■ Search using keywords. The user can search against single or multiple keywords. 
In the case of multiple keywords, a default term separator is inserted between 
query terms. 

■ Performing searches with Boolean operators. Boolean operators refer to terms 
which allow a user to refine a search. These terms are AND, OR, and NEAR. For 
a list of search term operators including variant forms of Boolean operators see 
“Search Operators and Connectives” on page 20.

■ Searching on multiple categories with one search. When performing an 
advanced search, the user may choose from a number of categories listed in the 
the Search drop-down list against which they can search.

■ Refining a search. Once a search result has been found, users can further refine 
their search by selecting new categories, modifying the query term, modifying 
the operators or changing filter field values. 

■ Changing the search settings used during a search. Searches can be constantly 
refined and changed.

■ Searching for external documents. Documents outside the Siebel file system can 
be searched upon and retrieved.

■ Drilling into a search result. Search results can be presented in the form of links 
which allow the user to click the link and drill down for further information.

■ Previewing a search result with the selected record in the main view area. 
(Search Center only)

When the Preview button in the Search Center is invoked, a database record is 
opened in a pop-up window allowing users to view the record without changing 
their current application context. External files are opened and presented in their 
native application. 
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Search Operators and Connectives
■ Attaching a search result to a selected record in the Search Center window 
(Search Center only).

Invoking the Attach feature allows a user to attach database records to the 
selected parent record in the Search Center window. 

■ Launch a SmartScript from the Search Center. 

■ Setting the Customer Dashboard. Employees can set the values in the selected 
search result into the open dashboard. (Search Center only). 

Search Operators and Connectives
In addition to AND and OR, and their symbolic equivalents & and |, Siebel Search 
can accept other operators, which are summarized below in Table 1.

Table 1. Search Operators and Connectives

Operators and 
Connectives Effect

AND, and, & Placed between terms, returns only items containing both terms.

OR, or, | Placed between terms, returns items containing either term or both 
terms.

* Placed anywhere in a string, returns items containing the string, or 
containing the string plus any additional characters at the position at 
which it appears, up to (or beginning with) a space. 

? Placed anywhere in a string, returns items containing the characters 
specified in the string, such that any character may appear at the 
location of the question mark.

““ Surrounds a string that, unless modified by a wildcard, must be 
matched exactly; allows searching for groups of words in their exact 
order.

() Orders that the terms and operators surrounded by the parentheses be 
processed first, regardless of the default processing order.
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NOTE: The NOT operator used between two query terms can be used to limit the 
results in a query to records which contain the first term but not the second term. 
Indices are built with one field mapping to a SUMMARY column, and all other fields 
or document text mapping to the EXTERNAL_TEXT column in the index. Queries 
with the NOT operator apply to both the External Text and Summary columns in the 
search index, and return records which satisfy the search criteria for both the name 
and summary fields.

white space 
character

In a pattern the space separates terms that must appear in a sequence. 
For example, when you enter “on line” (with quotes), this pattern 
would match any occurrence of the word ON followed by spaces, tabs, 
new lines, or any other white space characters in any combination, 
followed by the word LINE. Quotes are necessary when using white 
spaces between terms because without them the terms are treated as 
different words.

- The hyphen character is treated as an optional punctuation character. 
The non hyphenated forms include spaces or anything that is 
interpreted as a punctuation character in Fulcrum.

\ This is an escape character that, when placed immediately before any 
special pattern character (hyphen, *, backslash, ?, or space) in a 
pattern, causes the special pattern character to be interpreted literally.

Table 1. Search Operators and Connectives

Operators and 
Connectives Effect
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Search Queries
Table 2 shows a number of examples of queries using these operators and the 
results they return. Note that search operators are conventionally displayed in 
uppercase; however, query strings are not case-sensitive, and your operators need 
not be in uppercase. Note also that the result may be affected by the operator you 
selected in the “Separate Terms With” drop-down list in the Siebel Search options 
property sheet. This setting determines which operator is assumed when no 
Boolean operator appears in the query.

For instructions on administering these settings, see Chapter 6, “Administration of 
Siebel Search.”

Table 2. Search Query Examples

Operator Query Type Query Example

Separate 
Terms 
With

Returns All Records and 
Documents That:

AND AND query performance AND 
memory

N/A Contain both performance 
and memory

& AND query performance & 
memory

N/A Contain both performance 
and memory

OR OR query performance OR 
memory

N/A Contain either performance 
or memory

| OR query performance | 
memory

N/A Contain either performance 
or memory

"" Phrase query "memory 
performance"

N/A Contain the entire phrase, 
memory performance

memory 
performance

AND Contain both performance 
and memory

memory 
performance

OR Contain either performance 
or memory

"" "" Multiple 
phrases

"Microsoft 
Windows" "Sun 
Solaris"

AND Contain both Microsoft 
Windows and Sun Solaris
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"" "" Multiple 
phrases

"Microsoft 
Windows" "Sun 
Solaris"

OR Contain either Microsoft 
Windows or Sun Solaris

? Wildcard operate? N/A Contain operates or 
operated, but not operate

? Wildcard ?rag N/A Contain brag, crag, drag, or 
frag

* Wildcard *rang* N/A Contain any of arrange, 
arranged, arranges, 
arranging, orange, 
orangutan, range, ranges, 
ranging, rang, sprang, 
strange, stranger, strangest, 
strangle, wrangle, and so 
on.

( ) Grouping (word OR excel) 
AND NOT 
microsoft

N/A Contain either word or 
excel but do not contain 
microsoft

( ) Grouping (word OR excel) 
NOT microsoft

N/A (Error)

( ) Grouping word OR (excel 
AND NOT 
microsoft)

N/A Either contain word, or 
contain excel and have no 
reference to microsoft 
(microsoft may appear in 
the same document as 
word, but not in the same 
document as excel)

Multiple 
search terms

word OR excel 
NOT microsoft

N/A Contain anything (finds all 
records and documents)

Multiple 
search terms

word OR excel 
AND NOT 
microsoft

N/A Contain either word or 
excel but do not contain 
microsoft

Table 2. Search Query Examples

Operator Query Type Query Example

Separate 
Terms 
With

Returns All Records and 
Documents That:
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This chapter provides an overview of configuration and administration tasks which 
will be discussed in greater detail in the chapters which follow.
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Setup Overview
Enabling Siebel Search requires setting up a server to act as a Search server. This 
server will contain both the Siebel Server and the Hummingbird SearchServer. 
Indices should physically be located on this machine. Searches done from the Web 
client can be done directly on the URL corresponding to the Search server or 
through another Siebel Server. In this case, the Siebel Server would pass the search 
execution request through to the Search server. Administration, performed from the 
Web client, must be performed on the Search server and not remotely through 
another Siebel Server. Mobile Web clients have the option of synchronizing the 
indices from the Search server onto a local machine. In this case, Hummingbird is 
required to be installed on the Mobile Web client to enable search execution.

Siebel Search can be deployed in a one or a combination of three ways. Figure 1 
displays each of these scenarios. An overview of the tasks required to implement 
each of these search scenarios follows.

Single Server and Web Client. A Search server consists of a Hummingbird installation 
and a Siebel Server. This server is used to create and administer indices. You must 
have at least one Search server installation for a Siebel Search rollout to work. This 
installation scenario is the basis for all others which follow.

■ Install Hummingbird SearchServer onto a designated Siebel Server machine.

■ Install Siebel Server software onto the Siebel Server machine.

Figure 1. Siebel Search Architecture
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Multiple Server and Web Client. A Siebel Server connected to a designated Search 
Server with a client connector. 

In addition to installing Hummingbird and Siebel Server software onto your 
designated Search Server, you must also do the following:

■ Install Siebel Server software onto additional enterprise machines.

■ Install Hummingbird client connector onto the designated Search Server 
machine.

Mobile Web Client. A mobile client which synchronizes with a Siebel Server to obtain 
updated search indices.

In addition to installing Hummingbird and Siebel Server software onto your 
designated Search Server, to deploy mobile client search capability, you must do the 
following:

■ Install Hummingbird software onto the mobile client machine.

■ Make sure that the mobile clients have connectivity to a Siebel Server. 
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Installation and Setup Overview
The concepts and methodology for setting up Siebel Search on your system are 
discussed in this chapter. You must follow the procedures in order to properly set 
up Siebel Search on your system. These steps are listed below.

1 Uninstall previous versions of Hummingbird SearchServer software.

Siebel Search 7.5 integrates with Hummingbird SearchServer 5.0. You must 
uninstall all previous versions of Hummingbird SearchServer software. See 
“Upgrade Notes for Windows Users” on page 40 for instructions.

2 Install Hummingbird SearchServer.

This installation must take place on a designated Siebel Server machine. You 
must install Hummingbird before installing any Siebel Server software. 
Depending on your platform, see “Installing Hummingbird SearchServer 5.0 
Under Windows” on page 42.

NOTE: If you are enabling Siebel Search capabilities for mobile clients, each 
mobile client machine must have Hummingbird software installed.

3 Install Siebel Server software.

You must install Siebel Server software on the same machine where 
Hummingbird was installed. This machine is your search server. Indices will be 
created and maintained on this machine. See “Configuring Siebel Server as a 
Search Server Under Windows” on page 43.

a Set up an ODBC data source (Windows users with Oracle database).

You must create an ODBC data source to create search indices when using 
Windows with an Oracle database. See “Additional Steps for Oracle Database 
Users Under Windows” on page 44.
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4 Install a Hummingbird client connector (For Remote Searching only).

The client connector gives users access to Hummingbird search capabilities from 
another machine. To enable remote searching, you must install a client 
connector on the machine you have designated as your search server. 

Depending on your platform, see “Creating a Hummingbird Client Connector 
Under Windows” on page 48 for instructions on setting up a client connector.

5 Install Hummingbird SearchServer software on each mobile client that will be 
synchronizing the indices maintained on your search server (Mobile Client 
only).

For installation instructions, see “Installing Hummingbird SearchServer 5.0 
Under Windows” on page 42.

6 Make sure mobile client machines have access to a Siebel Server to synchronize 
indices (Mobile Client only). 

For instructions on synchronizing mobile clients with a Siebel Server, see 
“Setting Up for Mobile Client Searching Under Windows” on page 51. 

7 Use Siebel Tools to perform any additional configuration or custom 
configuration on your search operations.

For instructions on configuring search operations with Siebel Tools, see 
Chapter 5, “Siebel Search Configuration Using Siebel Tools.”

8 Set up search settings and index settings. 

For instructions on setting up search settings and index settings, see Chapter 6, 
“Administration of Siebel Search.”

9 Build and maintain search indices.

For instructions on building search indices, see Chapter 6, “Administration of 
Siebel Search.”
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Hardware Recommendations for Hummingbird SearchServer
Hummingbird SearchServer can be installed on the same server as the Siebel 
Enterprise Server or the Siebel Database Server. For larger installations, however, it 
is recommended that SearchServer be installed on a dedicated server, with a 
minimum of 250 MB of RAM. The CPU and memory resources required for 
operation of Hummingbird SearchServer increase with the number of active users 
at any one time. Each concurrent user requires approximately 2 MB of RAM on the 
server. A concurrent user is defined as an employee or partner with search center 
open, or a customer with the Search view active.

Up to 50 MB of disk space is required on the application server for installation of 
the Hummingbird SearchServer software. The size of indices is approximately 30% 
of the size of the original text, and the indexing step requires temporary space of up 
to two to four times the ultimate size of the index files. Additionally, indices which 
are based on business components pointing to files in the Siebel file system require 
additional temporary storage space roughly equal to 2X the size of the compressed 
files being indexed.
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Configuration and Administration of Siebel Search
Configuration and administration of Siebel Search is performed through Siebel 
Tools, and through administration screens in your Siebel application. 

Find objects are configured solely through Siebel Tools. There are no administration 
screens for Find. 

Siebel Search uses a technology called full-text search where a “search index” is 
created that transforms the content of documents or database fields into a form that 
is very efficient for searching. At a high level, Siebel Tools configuration defines 
what these indices should be, and administration actually creates the indices.

For information on Siebel Tools Configuration of Search see Chapter 5, “Siebel 
Search Configuration Using Siebel Tools.”

For information on Administration of Siebel Search see Chapter 6, “Administration 
of Siebel Search.”

Introduction to Siebel Tools
Siebel Tools is a declarative software development tool which allows you to 
configure the underlying data and data presentation of your Siebel application 
without making changes to the program source code. Standard Siebel applications 
provide a core set of search object definitions that you can use as a basis for your 
tailored application. There are no source code modifications, nor modifications to 
schema. Tools creates and maintains a custom Siebel Repository (.srf) file to store 
your custom configurations. 

Chapter 5, “Siebel Search Configuration Using Siebel Tools,” introduces and 
explains basic Tools object definitions and outlines advanced configuration tasks 
which allow you to further customize your application. Below are listed some basic 
concepts important to an understanding of Siebel Tools configuration of Search. 
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Find Objects
A Find object definition, which is set up in Siebel Tools, specifies what Find objects 
and fields will be available when a user invokes a Find operation. 

Each item in the Search Center’s Find list identifies a business component whose 
records can be searched for matching values that have been entered in the 
Keywords text box. For instance, if a user searches one term against the Accounts 
field, the search engine will take the entry, add an asterisk character (*) at the end 
of the term, and send that information to the query engine. Find queries are case 
sensitive by default, but this setting may be changed. If multiple fields are entered, 
the entries will be connected with a Boolean AND. 

NOTE: You can enter the operator “=” before a query term and the engine will look 
for an exact match instead of doing a “Starts with” (which appends a wildcard at 
the end of the query).

For more information on Find objects, see “Siebel Tools Objects for Find” on 
page 70.

Search Objects
A search object is a logical entity that defines all search characteristics and 
behaviors for a chosen object. A search object includes in its definition attributes 
such as business component and field to search upon, drill down results views, and 
records which may be associated with a particular result.

For more information on search objects, including standard and advanced Tools 
configuration of your Siebel Search operation, see “Siebel Search Configuration 
Using Siebel Tools” on page 53.
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The Differences Between Search and Find Operations
Find is a powerful tool that consists of a direct query on a database and allows users 
to query on a field by field basis. Find is accessible from anywhere in your Siebel 
application, and allows users to perform queries on specific predefined fields linked 
to specific business components (such as querying for an employee last name). 
Since Find directly queries the database instead of using indices, the results of these 
queries always match with the actual data in the database. This makes Find 
appropriate for searching on transactional database tables that frequently are 
changing.

A Search operation by contrast, allows a simpler, broader search by not requiring 
the user to specify the business component or field to search upon. Full text 
searches can be performed across multiple business components and files with one 
operation. An important difference between search and find is the visibility applied 
to the results. See “Visibility Control” on page 33 for details on the differences.

Visibility Control
Visibility determines the set of records displayed to the user from specific business 
components in the search results. The user’s access to records is determined 
through a combination of user position, Siebel Tools object attributes, and record 
values. 

For more information on setting up visibility within your Siebel application, see 
Security Guide for Siebel eBusiness Applications, MidMarket Edition. 
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Visibility Control for Find
Find operations within Siebel applications are instituted in the following ways:

■ Position visibility: This view displays data associated with the user’s logged on ID. 
This view displays only those records to which the logged-on user has Team 
visibility— that is, account records in which the user’s positions appears in the 
team multi-value group.

■ Team visibility: This view displays only those records to which the logged-on user 
has Manager visibility—that is, records from which the primary position on the 
account team is the logged-on manager’s direct or indirect subordinate. 

■ Organizational visibility: This view displays data associated with the same 
organization to which the logged on user’s position belongs. 

Each view within Find has a certain visibility to which it is associated. These views 
are listed in order as part of the find object. When a user invokes a Find operation, 
the system scans the views from top to bottom until it finds a view to which the 
user has visibility. The visibility used for this view will be applied to the Find result 
set.
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Visibility Control for Search
Visibility control can be set up in Siebel Tools for each search category. Visibility 
rules are defined as follows:

■ Multi-Organizational access control. “Multi-org” visibility provides a logical layer 
above the visibility controls at the enterprise, limited, and personal levels. With 
it you can limit visibility at the individual level of information such as accounts, 
contacts, and opportunities within a single organization. Access is limited to 
individuals whose positions have been placed on virtual teams for each record. 
Additional entities, such as products and price lists are limited at the business 
organizational level rather than the level of individual user, and access is 
controlled at this level. 

■ Catalog Category. Limits access of groups of users to catalogs and categories of 
content. If catalog category control is used for a particular search object, any 
records that are not associated with any content category will not display as a 
search result. For more information, see Security Guide for Siebel eBusiness 
Applications, MidMarket Edition.

■ Access Group. You can index fields to enforce existing Access Group visibility 
rules within your Siebel enterprise. For more information, see Security Guide for 
Siebel eBusiness Applications, MidMarket Edition.

Filter Visibility for Search
Siebel Search also contains predefined search specifications which allow you to do 
the following:

■ Create search categories with pre-set search specification. For example, if 
Literature status=”published” then no records that are in draft form will be 
considered during a search. This visibility control is organization wide, no 
matter the responsibility of the user.

■ Create multiple search categories on the same business component to give users 
greater granularity to control their searches. For example, you can have one 
search category in your application called “White Papers” based on the literature 
business component, and another category called “Brochures” which is also 
based on the literature business component. A user can then perform a search 
on white papers, without searching on all literature items. 
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Search Time and Index Time Filters
Search time filters can be either implicit or explicit filters of search results. Implicit 
filters are applied to search results in the form of a filter search specs on the search 
category. Explicit filters come in the form of exposed UI filter fields on the Search 
Center. For more information, see “Using Search Filters in Filter Search Specs” on 
page 86. 
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This chapter describes how to install and configure Siebel Search on your Windows 
system. 
Version 7.5 Siebel Search Administration Guide MidMarket Edition 37



Installing Siebel Search Under Windows

Before You Install Hummingbird
Before You Install Hummingbird
Siebel Search 7.5 uses Hummingbird SearchServer 5.0, the successor product of 
previous Fulcrum versions. Hummingbird SearchServer 5.0 server can be installed 
on a Windows 2000 computer.  

CAUTION: The Hummingbird SearchServer 5.0 server should be installed on the 
designated Siebel Server before any Siebel software installations can be performed.

Make sure that the following requirements are met before you begin the installation 
process: 

■ You must have administrator permission for the machine on which you will be 
installing Hummingbird. For information on setting up appropriate permissions 
for installation, see Siebel Server Installation Guide for Microsoft Windows, 
MidMarket Edition.

■ If you plan to have very large indices (or frequent searches and indexing), you 
should use a dedicated Siebel Server. 

■ Make sure that you have enough disk space for the indices. When the indexing 
engine is run, two sets of index files exist until the final sort file is merged with 
the existing dictionary and reference file. Until a single updated set of index files 
is generated, temporary space requirements for indexing can be two to four 
times the ultimate size of the index files. 

■ The Search server machine must have client connectivity to the database.

■ You must determine where the shared document indices will be kept, create a 
share name for the location, and give all users read access to it.
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Preinstallation Checklist
Before you can proceed with your installation, you should decide on the following 
issues. The following table provides a list of questions and a column for your 
answers.

Question Response

Will the installation be for a Search Server or for 
a Remote Search Server?

Is this the only Search Server in your Siebel 
install, or will you be using multiple Search 
Servers?

Do you have a good understanding of the load on 
your system, once Search is deployed? 
Predetermining users and servers, will allow you 
to estimate the amount of memory, disk space 
and processor power required to optimize the 
Search Server performance.

What languages do you want to support in your 
searches?

Are there any configuration changes you plan to 
make to Hummingbird? 

What applications will you be using Siebel 
Search with?

Will you be installing Siebel Search for mobile 
client searching?

What database system will you be using?

If you are upgrading from a previous release of 
Siebel Search, you will need to rebuild your 
indices. 

If you are upgrading from a previous release of 
Siebel Search, you will need to rebuild your 
search index structure using Siebel Tools. 
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Upgrade Notes for Windows Users
If any previous version of Hummingbird (formerly Fulcrum) SearchServer is already 
installed on your Windows machine, log on as a System Administrator and use the 
following procedure to remove it before installing version 5.0 of SearchServer.

NOTE: Siebel Search 7.5 integrates with Hummingbird SearchServer 5.0. If you have 
used a prior version of Siebel Search, you must upgrade Hummingbird SearchServer 
to version 5.0.

To remove an earlier version of Fulcrum

1 From the Windows Start menu, choose Settings > Control Panel. 

2 Double-click the Services icon. 

3 Double-click on any of the listed Fulcrum services, then select disable.

These services may include:

■ SearchBuilder for VB/C++

■ Fulcrum FulView

■ International Linguistic Option

■ International Thesaurus Option

■ SearchServer

■ Fulcrum Server

■ SearchServer Desktop

■ SearchServer Administrator

■ Fulcrum Server Manager

■ Fulcrum Servlet Runner

4 Once all the Fulcrum Services have been marked Disabled, close the Services 
Window.
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5 On each server and client running SearchServer 3.7, do the following: 

a Note the directory in which Hummingbird is currently installed (the default 
is c:\Program Files\Hummingbird). You will be installing SearchServer 5.0 in 
the same directory.

b From the Windows Start menu, choose Settings > Control Panel > Add/
Remove Programs.

c From the list of installed programs, click any of the following that appear, and 
click Install/Uninstall. 

❏ SearchBuilder for C, SearchBuilder for VB/VC++, or SearchBuilder for 
VB/C++

❏ Fulcrum FulView

❏ International Linguistic Option

❏ International Thesaurus Option

❏ SearchServer

❏ SearchServer Desktop

❏ SearchServer Administrator

❏ FTMF 5.2.1 Service Pack 1 for SearchServer 3.7.

❏ Ir FulcrumEn 1.0.25

NOTE: If your previously installed version of Fulcrum SearchServer is version 3.7 
or earlier, you may be required to perform the following steps.

6 On the My Computer icon on your desktop, right click and choose Properties.

7 Click the Environment tab.

8 In the User Variables window, navigate to PATH, highlight the path including 
c:\Fulcrum\bin.

9 Delete this portion of the path, then restart your machine.
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Installing Hummingbird SearchServer 5.0 Under 
Windows

The Hummingbird SearchServer 5.0 server can run on a Windows 2000 computer. 
You can install Hummingbird SearchServer 5.0 from the Siebel Windows Server 
Ancillary Programs CD-ROM or from its location on your network. 

To install Hummingbird SearchServer under Windows

1 On the Siebel Windows Server Programs CD-ROM, or on a network directory 
containing the Siebel install files, navigate to 
Thirdpty\language\Hummingbird\enu. 

2 Double-click setup.exe. 

Hummingbird installation screen appears with list of options. Click Install 
Search Server option. Setup then prepares the InstallShield Wizard used to 
install the software.

3 Accept the license agreement, and then in the SearchServer 5.0 Setup dialog box, 
enter the required information, including, in the serial number field, the license 
key listed in Table 3. 

4 In the Choose Destination Location dialog box, click Next to accept the default 
directory location, or click Browse to select your own location, and when you 
have chosen your default directory, click Next.

5 In the Select Components dialog box, accept the defaults, then click Next.

6 In the Hummingbird SS Servlet Runner Setup Options dialog box, accept the 
default port number, then click Next. 

7 In the JDBC Driver Port Selection dialog box, accept default, then click Next.

8 Choose a program folder, then click Next to start the installation.

Table 3. SearchServer License Key

Operating System License Key

Microsoft Windows 2000 BAB0F794D92E6150
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9 Click Finish, then in the Question dialog box, click Yes to start the new services. 

10 On the ancillary products CD, open up the windows_patch_t.zip file in the patch 
directory. Extract this to the SearchServer install directory (for example, 
Hummingbird\SearchServer50) with the Use Folder Names option selected.

NOTE: If you are using an Oracle database under Windows, see “Additional Steps for 
Oracle Database Users Under Windows” on page 44.

Configuring Siebel Server as a Search Server Under 
Windows

After installing Hummingbird SearchServer 5.0 on your designated search server 
machine, you must then install Siebel Server software. Make sure that this machine 
has connectivity to a Siebel Database Server. 

NOTE: During the Siebel Server installation, the system will check whether 
Hummingbird has been installed. If it has previously been installed, you will be 
required to answer questions regarding search server setup. If Hummingbird is not 
installed, you will be asked questions related to connecting to a remote search 
server. 

If you install Hummingbird after installing your Siebel Server, you will need to 
manually modify server parameters. For information on modifying server 
parameters, see Table 4. 

To configure Siebel Server as a search server under Windows

1 Run Siebel Server installation wizard.

2 Click the Configure as Search Server checkbox to setup the Siebel Server as a 
search server. 

3 Follow the remainder of the installation instructions listed in Siebel Server 
Installation Guide for Microsoft Windows, MidMarket Edition.
Version 7.5 Siebel Search Administration Guide MidMarket Edition 43



Installing Siebel Search Under Windows

Configuring Siebel Server as a Search Server Under Windows
Additional Steps for Oracle Database Users Under Windows
To create search indices on an Oracle database, you must set up an ODBC data 
source. The procedure below is for Windows 2000.

To set up an ODBC data source for an Oracle database

1 From the Windows Start menu, choose Settings > Control Panel.

2 In the Control Panel window, click Administrative Tools, then click Data Sources 
(ODBC).

The ODBC Data Source Administrator appears.

3 Click the System DSN tab, then click Add to create a new Data Source.

4 Click the Add button to create a new Data Source.

The ODBC Data Source Administrator window appears.

5 Select Microsoft ODBC for Oracle, and click OK.

6 In the Setup window, enter Siebel_Search for the Data Source Name, and your 
database connect string in the Server field.

7 Click OK.
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Siebel Search Parameters
If you install Hummingbird after installing your Siebel Server, you will need to 
manually modify server parameters.

Table 4 on page 46 shows the Siebel Search Parameters and display names, and 
provides a definition for each. Typically, you will not need to modify these 
parameters. They are configured at the time of installation by the Siebel Installation 
Wizard if Hummingbird is installed before you installed the Siebel Server. However, 
if you install Hummingbird after the Siebel Server installation, you will have to 
manually set some of these parameters. If you need to access these parameters, they 
can be accessed in the configuration files or in the name server shared memory. 

The SearchDefName is different from other parameters because it is an enterprise 
level parameter in the Siebel Server. See “To view or modify the SearchDefName 
parameter” for information.

To access the parameters on the server

1 Navigate to Server Administration > Servers.

2 Click the Server Parameters view tab.

Retreive or modify these parameters.

To view or modify the SearchDefName parameter

1 Navigate to Server Administration > Enterprise Configuration.

2 Click the Component Definitions view tab.

3 Select a component in the Enterprise Configuration screen.

For example, Call Center Object Manager.

4 Query for Search - Definition Name in the Component Definition View.

This will allow you to see the Search Definition for the chosen component. This 
definition will be used for all servers in the current enterprise.
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To access these parameters on the dedicated or mobile Web client you go to the 
configuration files. For example, in the bin\enu\uagent.cfg file for the Call Center 
application, you will see these parameters under the [SIEBEL] section. 

NOTE: The display name appears in the Server Administration Screen in the Siebel 
Server.

NOTE: To view or modify the remaining four parameters, navigate to Server 
Administration > Servers > Server Parameters. These parameters are not 
enterprise level parameters; therefore two servers in the enterprise may have 
different values. For example, in order to share the same enterprise information you 
install two Siebel Servers on two different machines, then you can choose to have 
different Hummingbird installation directories. In this case, the directory 
SearchInstallDir will have different values. 

Table 4. Siebel Search Parameters

Siebel Parameter Display Name Parameter Definition

SearchEngine Search- Engine Name The Search Engine name. In the case of Version 
7.5, the Search Engine definition is Fulcrum.

SearchDefName Search- Definition Name Identifies a group of search categories that can 
be searched against. Each Siebel application (for 
example, Call Center or eService) comes 
configured with a predefined search definition. 
The search definition is specified in the 
application.cfg file or name server and is used at 
run time to load the appropriate search 
categories. 

SearchInstallDir Search- Install Directory The directory where Fulcrum is located. For 
example: C:\PROGRAM FILES\FULCRUM.

RemoteSearchServer Search- Remote Server This parameter must be set to FALSE to allow 
administration work on any of the Fulcrum 
search indices. Setting this parameter to TRUE 
allows Remote Searching.

RemoteSearchServerPath Search- Remote Server path The machine and the port number that enables 
connectivity to the Remote Search Server. For 
example: searchserver/tcp2048.
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Setting Up Employee or Partner Users
Any employee or partner users of Siebel Search in search center must have the 
following views as part of their responsibility:

■ Basic Search Results View

■ Basic Search View

■ Search Selection View

Setting Up Customer Users
To allow customers to use Siebel Search on customer applications, you must 
associate the following views: 

■ Advanced Search View (DotCom)

■ Advanced Search Results View (DotCom)

■ Basic Search View (DotCom)

■ Basic Search Results View (DotCom)
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Setting Up Siebel Server for Remote Searching Under 
Windows

If you are going to set up Siebel Search with remote searching, you must include at 
least one additional Siebel Server with a client connector that will allow users 
access to the search indices located on the Search Server. 

Creating a Hummingbird Client Connector Under Windows
To configure Search Server 5.0 to work in a client/server environment, you need to 
configure the server, then the client. To enable remote searching, you must create a 
client connector on the machine where Hummingbird Search Server 5.0 was 
installed. 

Configuring a server node involves defining one or more services, each of which 
corresponds to a unique network access path that will respond to a valid client 
connection request by activating a Search Server process. The server process acts 
as the client's agent and provides access to the set of tables associated with the 
access path. After configuring the server, you should configure the client and use it 
to verify the client and server configuration.

Configuring the Server for Remote Searching
To create the server in the Hummingbird Connector Manager, complete the 
following steps: 

To create a client connector on the server

1 From the Windows Start menu, choose Programs/Hummingbird/Search Server 
5.0/Hummingbird Connector Manager.

2 Locate the Siebel Server directory. For example: c:\siebsrvr\...

3 Click Setup, and then click Add in the Hummingbird Connector Server Service 
Setup dialog box.
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4 Enter the values as shown below:

a Select Automatic to start the service automatically when the computer is 
started.

b Client Connector: The client connector uses the symbol for the network 
protocol in use, and the port. The default protocol along with port number is 
tcp2048.

c Fulcreate: Specify the location where the tables will be created. Multiple 
directories must be semi-colon separated. For example, 
C:\siebsrvr\search\ServerDataSrc\index.

d Fulsearch: Specify the directory or directories where the tables will be 
searched. For example, C:\program files\Hummingbird\Search 
Server5.0\fultext;C:\siebsrvr\search\ServerDataSrc\index.

e Fultemp: Specify the location for temporary files during indexing and 
searching operations. For example, C:\siebsrvr\search\ServerDataSrc\temp.

For information on Environmental Variables, see Appendix A, “Siebel Search 
Environmental Variables.”

5 For the Connection Security option, choose Ignored (default is also the Ignored 
option).

6 Start the service by clicking OK, and then click Close.

7 Highlight the service and click Start.

8 If you wish, click Close. (If you close the window, you will have to reopen the 
Hummingbird Connector Manager when you want to stop the service.)

The service must be started before users can access the search indices through 
the client connector.
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Configuring the Client for Remote Searching
To create the client for remote searching in the Hummingbird Connector Manager, 
complete the following steps:

To configure Siebel Server for remote searching under Windows

1 Run Siebel Server installation wizard.

During the installation process you will be presented with the following dialog 
box. 

2 Enter the Remote Search Server Name, and Port Number. 

3 Follow the remainder of the installation instructions listed in Siebel Server 
Installation Guide for Microsoft Windows, MidMarket Edition.
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Setting Up for Mobile Client Searching Under Windows
Mobile clients can use Siebel search in disconnected mode by installing and setting 
up Hummingbird on their machine, and synchronizing the indices from the search 
server. Just as with the search server installation, Hummingbird should be installed 
before proceeding with the Siebel mobile client installation. As long as this is done, 
all configurations will be set up automatically. Then, during the synchronization 
process, indices will be copied from the search server machine into the Siebel file 
system. 

When Mobile clients work in connected mode, the mobile client can send search 
requests to a remote search server. When installing mobile clients, you will be 
required to enter a remote search server name and port number. See “To configure 
Siebel Server for remote searching under Windows” on page 50 for details. 

For more information on:

■ Hummingbird installation instructions, see “Installing Hummingbird 
SearchServer 5.0 Under Windows” on page 42.

■ Index synchronization on a mobile client, see “Synchronizing Indices on the 
Mobile Web Client” on page 105. 
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This chapter provides information about implementing and configuring Siebel 
Search for your Siebel application. A knowledge of Siebel Tools is assumed. This 
chapter does not provide basic Siebel Tools knowledge. For information about 
Siebel Tools see Siebel Tools Reference, MidMarket Edition. 
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Preconfiguration Checklist
Before you proceed with your configuration, you should decide on the following 
issues. The following table lists questions and provides a column for your answers.

Question Response

Do you want to index a Unicode or a code page 
database?

If indexing a Unicode database, do you want to 
optimize the index in a particular language? 
(This decision has to be made depending on 
which language data the database uses 
predominantly.)

What do you want to search? Database tables 
and external documents? 

If searching on database tables, what are the 
names of the tables and the business 
components?

Do you know the approximate sizes of the 
table data that you plan to index? If indexing 
Siebel file attachments, the sizes should be 
determined as well. For a table that supports 
periodic indexing, as is the case with all Siebel 
generated Search Server tables, the index 
overhead is typically in the range of 25% to 
50% of the total text size. For information, see 
the Hummingbird documentation.

If searching on external documents, what is 
the location of the file server holding the 
external documents and the name of the 
highest-level directory containing those 
documents? 

What are names of the Siebel database tables 
that you want to search and their location on 
the network?

What configuration changes (if any) you plan 
to make to Hummingbird?

Will you be installing Siebel Search for mobile 
client in disconnected mode?
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Basic Siebel Tools Objects for Search
All the Siebel Tools objects necessary to build and configure basic Search 
capabilities in a Siebel application are set up automatically during Siebel 
installation. This section explains each of these basic Siebel Tools objects, any rules 
and assumptions associated with them, and includes a list of relevant object 
properties.

For information on custom configuration of search operations, see “Advance 
Configuration of Search Operations” on page 78.

Figure 2 displays all the Siebel Tools objects for Siebel Search and their relationship 
to one another. 

Figure 2. Search Objects in Siebel Tools
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The Search Engine
Hummingbird is the only search engine supported by Siebel Search 7.5. 
Hummingbird is predefined at the time of Siebel installation. There is no need to 
define an additional search engine. 

The Search Engine Object
The search engine is predefined by Siebel during initial installation as 
Hummingbird. The adapter class, CSSFulcrumSearchAdapter is also specified. 

Properties
Table 5 lists the properties for the Search Engine object.

The Search Result Field Object
The Search Result Field object lists all fields that are included with and used by 
every search index table created for the search engine. Standard Result Fields are 
predefined for the search engine at installation and represent an application defined 
physical column in the search table, or a reserved column required by the search 
engine. All search tables that belong to the search engine will include and use all 
fields defined under Result Fields. 

Siebel is installed with a default set of Search Engine Result Fields. There is no need 
to create additional fields, unless you have a requirement. For instructions on how 
to customize the result fields see “Advance Configuration of Search Operations” on 
page 78. 

Table 5. Search Engine Object Properties

Property Required Description Comments

Name Required The name of the search engine. For 
example, Fulcrum.

Class Required The C++ class name of the search adapter. 
For example, CSSFulcrumSearchAdapter is 
the adapter for the Fulcrum Search Engine.
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Rules and Assumptions
■ All fields defined here will be created for all the search tables belonging to the 

search engine.

■ Some of these fields can be customized for each search definition. 

Properties
Table 6 lists the properties for the Search Result Field object.

Table 6. Search Result Field Object Properties

Property Required Description Comments

Column Name Required The name of the physical column in the 
search index that varies with the vendor of 
your database software.

These columns may contain a 
column name or a function.

Create Column 
Flag

Optional A flag that denotes which columns will be 
actually created in the Search Table.

Some fields defined are 
system columns that need not 
be explicitly created. They are 
automatically created by the 
search engine.

Data Type Optional Specifies the data type of the column. Valid 
values are varchar, char, and apvarchar.

Required only for fields that 
are flagged TRUE in the 
Create column.

Index Mode Optional Specifies the index mode of the column. 
Valid values are literal, none, and normal.

The index mode specifies the 
type of indexing that is 
applied on the values.

Name Required The logical name of the field.

Text Length Optional The amount of storage, in bytes, allocated 
to a field.

Type Required A picklist with valid values displayed. Attribute Type can take the 
following values: System, 
Data (Public), Data (Private). 
None of the predefined fields 
can be deleted. Additionally, 
Data (private) fields cannot 
be customized.
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The Search Index
A default set of search indices are set up at the time of Siebel installation. There is 
no need to create new search indices. Should you need to create additional indices, 
the rules and assumptions and properties of the search index object are listed below. 

The Search Index Object
The Search Index object is a logical name for a group of search engine specific 
entities. For example, the Search Index for Hummingbird will be a Hummingbird 
index table. Thus, the search index, Solution will map to an index table called 
FUL_SOLN. 

Rules and Assumptions
■ It is a good practice to only index master data (also called referential data), and 

not transactional data as transactional data change very often and your index 
may not reflect the current data.

■ Search engines are most powerful when used to search for text and keywords in 
voluminous documents and attachments in the database. The perfect candidates 
for Search are Literature, Solution, Product, FAQ, and Resolution documents. 
Siebel 7.5 includes preconfigured search indices, for example, Product 
Literature, SmartScripts, Service Requests, and so on. 

■ Search supports Access Control and Organization visibility rules. The buscomp 
that you plan to index should support one of these rules. It is also acceptable to 
index buscomp that have no visibility rules enforced. In such cases, all buscomp 
records will be visible to all users. For further information on Access Control, see 
“Visibility Control” on page 33.
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Properties
Table 7 lists the properties for the Search Index object.

The Search Table
A search table physically represents the search index in Hummingbird. For example, 
the search index Literature is actually represented in Hummingbird as a table called 
FUL_LIT. The columns created for the search table are picked up from the Search 
Result Fields defined for the search engine. You do not need to create a new search 
table unless you previously created a new search index. If you do create a new 
search table, the table name and the search engine to which it is related must be 
specified. 

Rules and Assumptions
There can be only one entry for a search index, search engine combination. Multiple 
entries will be ignored, and the first entry used. For example, the search index 
Literature should have only one search table called FUL_LIT for the search engine 
Hummingbird. 

Table 7. Search Index Object Properties

Property Required Description Comments

Name Required Logical name for the search index.

Index Buscomp Optional Buscomp that the index maps to. This field 
can be null if it is based on an external 
directory.

DB Table Optional Flag indicates if the object maps to a 
database table or not. If the search index is 
based on an external file system, this field 
should not be checked. The default case is 
checked. 
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Table 8 lists the properties for the Search Table object.

Defining Index Field Maps for Search Tables
The Index Field Map object identifies fields of a buscomp to be indexed. This object 
specifies to the search engine the result fields to which the buscomp fields (or Index 
Fields) will map. Only result fields marked as Data (Public) can be mapped. 
Contents of the index fields will be indexed into the search engine result fields. The 
business component field that is mapped to the summary column should be a 
required field in the business component. If this field is empty for a record that 
shows as a search result, then the unique ID will be substituted into the summary 
field.

NOTE: Last Updated Time is implicitly added to the DID file and need not be defined 
in Tools under the Search Index Field Map object. Id is explicitly defined in Siebel 
Tools. 

Table 8. Search Table Object Properties

Property Required Description Comments

Table Name Required Actual name of the index table or the 
collection.

Engine Required Name of the search engine. For example, 
Fulcrum or Hummingbird.

Picked from the Search Engine 
Table

Inactive Optional

Comments Optional
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Table 9 lists the properties for the Index Fields object.

Table 9. Index Field Map Object Properties

Property Required Description Comments

Name Required Identifies a name for the field. This provides the ability to 
associate multiple index 
fields to result fields.

BC Field Required The active fields of the buscomp that is 
associated with the parent Search object. 
These fields will be included in the Search.

Result Field Optional Specifies the result field that maps to the 
index field. For example, you may want SR 
Abstract to be indexed into the Summary 
result field. By default, the contents of the 
index field are automatically indexed into 
the External Text result field. Note that the 
result field Document Text has been 
renamed to External Text in Siebel 7.5.

Used during the script file 
generation.

Field Type Optional Specifies the type of the Index Field. These 
types are, Attachment, Rev Num 
Organization, and Catalog Category, Access 
Group. 

NOTE: In Version 7.5, the 7.0 field type of 
Group has been renamed to Catalog 
Category. If you (the customer) have 
created any custom entries, the Tools 
migration script should automatically make 
this change.

Sequence Required
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Indexing File Attachments
To index file attachments, the buscomp should be a file buscomp. For example, the 
C++ file the attachment is based on should be CSSBCFile or a derivation of that. 

NOTE: Files in the Siebel file system will be accessed and indexed as part of the 
standard indexing operation. There is no need to uncompress these files as a 
separate process.

Rules and Assumptions
All file based buscomps have the format, <three letter identifier>FileName and 
<three letter identifier>FileRev. For example, in the case of the literature buscomp, 
the file names are LitFileName and LitFileRev. In Resolution Documents, the names 
are ResFileName and ResFileRev. 

NOTE: It is essential to map these two fields to index file attachments.

To index Literature file attachments, follow this format:

■ LitFileName needs to be mapped to the Document Text result field. The attribute 
Field Type has to be set to Attachment.

■ LitFileRev needs to be mapped to Revision Number result field. The attribute 
Field Type has to be set to Rev Num. Map this field to make sure that file 
revisions are included the next time you refresh the index. 
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Indexing Fields to Enforce Catalog Category Visibility
You can index fields to enforce existing catalog category visibility rules within your 
Siebel enterprise. 

NOTE: In its preconfigured state, most search categories in Siebel Search apply 
catalog category visibility. For these search categories, this means that a record must 
be associated with an access category for it to be available for searching.

Rules and Assumptions
■ The buscomp field Catalog Category Id should be mapped to Visibility Id result 

field and the attribute Field Type should be set to Catalog Category.

■ The Catalog Category Name buscomp field should be mapped to Visibility Info 
result field and the Field Type set to Catalog Category. The catalog category 
name is indexed to differentiate similar search results from each other. For 
example, the solution How to fix a modem may belong to two different catalog 
categories, and thus may show up twice in the search results when there is a hit. 
On the UI, these two results are prefixed with the catalog category to which they 
belong.

NOTE: These fields are usually available if the buscomp supports catalog visibility. 
If they are not, they can be added to the business component through suitable joins. 
See Siebel Tools Reference, MidMarket Edition for information.
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Indexing Fields to Enforce Access Group Visibility
You can index fields to enforce existing Access Group visibility rules within your 
Siebel enterprise. 

Rules and Assumptions
The buscomp field Access Group Id should be mapped to Visibility Id result field 
and the attribute Field Type should be set to Access Group.

NOTE: This field is usually available if the buscomp supports Access Group visibility. 
If the field is not available, it can be added to the business component through 
suitable joins. See Siebel Tools Reference, MidMarket Edition for information.

Indexing Fields to Enforce Organizational Visibility
You can index fields to enforce existing organizational visibility rules within your 
Siebel enterprise. To enforce organization visibility the buscomp that you are 
indexing should have a database table column (usually called BU_ID), that is single 
or multi-org enabled.

Rules and Assumptions
The buscomp field Organization Id should be mapped to the Visibility Id result field 
and its attribute Field Type set to Organization. 

NOTE: Only one visibility type is supported on a search index.
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Restrict Indexing of Records
The Search Server 5.0 database text reader (dbtr) permits partial table selection for 
improved performance. The text reader's table definition (which is defined in the 
DID file) can include a WHERE clause to specify which rows are included in the 
selection. To constrain the scope of data that is indexed, you can define a Search 
Filter Field in Siebel Tools, for the Search Index that you wish to constrain. The 
Search Filter Field object needs to have the Field Type set to Constraint and the 
constraint spec should be filled in the Column Name field. The string specified as 
the constraint is not checked for syntax and is added as is to the Hummingbird DID 
file. Please look at the Search Server 5.0 documentation for more details. 

NOTE: These fields cannot be used in filter search specs through a filter search spec 
or exposed on the UI as filter fields.

For example, to index only Literature items that are marked external, you add a 
Search Filter Field in Tools under Literature Search Index -> “FUL_LIT” Search 
Table:

■ BC Field: “Internal”

■ Field Type: “Constraint”

■ Column Name: “= 'N'”

■ Data Type: Character

■ Index Mode: Literal

■ Text Length: 1

Given the above filter field definition, the FUL_LIT.DID file generated by Siebel 
Search will have this extra line:

RESTRICT SIEBEL.”S_LIT”.”INT_FLG” = 'N'
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The BC Field you select for a constraint filter field can be any field in the buscomp 
including joined fields. For example, to index only the Product that belongs to 
Caterpillar organization, you add a Search Filter Field under Product Search Index 
-> “FUL_PROD” Search Table:

■ BC Field: “Vendor” (this is a join field)

■ Field Type: “Constraint”

■ Column Name: “= 'Caterpillar'”

■ Data Type: Varchar

■ Index Mode: Literal

■ Text Length: 100

The DID file generated will include the appropriate join clauses as well as the 
restrict clause:

RESTRICT SIEBEL.”S_ORG_EXT”.”NAME” = 'Caterpillar'
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The Search Category
A search category is an abstraction over a search index that allows you to define 
user interface elements, such as drilldown views and pick views for particular 
categories. To configure the search category you must define the search category 
object, then associate it to a search index. 

Creating a Search Category
A search category maps to a search index and defines a category that can be 
searched against. For example, the categories Solution (Call Center) and Solution 
(eService) map to the same search index Solution but differ in other attributes like 
Drilldown View or Filter Search Spec (defined under Search Definition Category 
object in Tools). See Siebel Tools Reference, MidMarket Edition for further 
information.

Siebel applications are installed with a default set of Search Categories. If you have 
a requirement for more search categories, make sure that the following rules and 
assumptions are followed and that the following properties are included in your 
object definition. 

Users can search on a keyword in Search Center and apply filter fields to that search.

Rules and Assumptions
■ Several search categories can be based on the same Search Index, just so that 

they could define different drilldown views and pick views. For instance, the 
Solution (Call Center) category, will drill down into Solution Resolution View 
and the category Solution (eService) to Solution Resolution View (eService).

■ Pick views can be defined differently for different search categories. For more 
information on creating pick views, see “Advance Configuration of Search 
Operations” on page 78.

■ Preview views can be defined by the eBusiness application user, allowing the 
user to define the type of pop-up view that will be displayed when Preview 
button is invoked. For more information on creating preview views, see 
“Creating Preview Views” on page 81.
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Properties
Table 10 lists the properties for the Search Category object.

Table 10. Search Category Object Properties

Property Required Description Comments

Name Required Logical name for the category.

Search Index Required Name of the search index.

Drilldown 
Buscomp

Optional The business component the user will drill 
down to. If this property is left blank, then 
it is assumed that the result category does 
not map to a database table.

Drilldown View Optional The view that appears when the user drills 
down. If this property is left blank, then it is 
assumed that the result category does not 
map to a database table. 

Destination 
Field

Optional The field in the destination business 
component whose value equals the value of 
the result row Id, in the index business 
component. If no value is specified, then it 
defaults to Id, which is the row ID of the 
destination business component.

Result Identifier Required An acronym that is used in the Summary 
column in the search result.

Preview Optional The view that appears when a user invokes 
the Preview button. 
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The Search Definition
The Search Definition object identifies a group of search categories that can be 
searched against. Each Siebel application (for example, Call Center or eService) 
comes configured with a predefined search definition. The search definition is 
specified in the application .cfg file or name server, and is used at runtime to load 
the appropriate search categories. 

Rules and Assumptions
■ Multiple search categories that refer to the same search index cannot be 

associated to the same search definition.

■ You must specify a name for the Search definition and also specify the sort 
specification. The Sort Specification contains result fields.
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Siebel Tools Objects for Find
As with Search objects, your Siebel application contains a list of application-specific 
Find objects. Find objects identify business components whose records can be 
searched for matching values that have been entered in the Search Center text 
boxes. Global Find items are used to perform finds on particular business 
components, and have corresponding names such as All Accounts, All Products, 
and so on. Following execution of a Find, the Results field in the Search Center lists 
records from the application that satisfy the Find criteria. 

Figure 3 displays all the Siebel Tools objects for Find and their relationship to one 
another.

Figure 3. Find Tools Objects
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Find Objects
A find object definition creates one entry that can be added to the Search Center 
drop-down list, and a corresponding set of find fields and possible views. The find 
fields and find views are implemented as child object definitions of the find.

Most applications already have a list of Find Objects, though some further 
configuration may need to be done.

Properties
Table 11 lists the Find Object properties.

Table 11. Find Object Properties

Property Required Description Comments

Applet Required The applet that will be used by the find. 
This applet must be included in the view 
specified for every Find View object 
definition for the Find object.

Destination 
Field

Optional A TRUE or FALSE value that, if TRUE, 
highlights this find object definition in 
Search Center drop-down list. This property 
applies only to the initial find operation in 
the application.

Leave for future release.

Display Name Optional

Menu Text Optional Reserved for future use. Not applicable.

Drilldown View Optional The view that appears when the user drills 
down. If this property is left blank, then it is 
assumed that the result category does not 
map to a database table. 

Name Required The name of the Find object definition. This 
is referenced when setting up application 
find object definitions that use this Find 
object definition.

Preview Optional The view that appears when a user invokes 
the Preview button.
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Application Find Objects
An application find object definition associates one Find object definition to one 
application. Application Find is a child object type of Application. The name of the 
Find object definition appears in the Find property in the Application Find object 
definition. Each application has multiple finds in the Search Center drop-down list, 
each one included by virtue of an Application Find object definition.

Properties
Table 12 lists the Application Find object properties. 

Table 12. Application Find Object Properties

Property Required Description Comments

Find Required The name of the find object definition to 
include in the application.

Examples: Contact, Account.

Name Required Same as the Find property.

Sequence Optional The order relative to other finds that this 
find object definition will be listed in the 
Search Center. 

Integer value.

Text Required The translatable text that appears as the 
title of the find dialog.
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Find Fi eld Objects
Find Field is a child object type of Find. A Find Field object definition adds a find 
field to its parent Find object definition. The find field appears as a text box in the 
Search Center when the parent find is active. Each child Find Field object definition 
provides the parent Find with a find value text box and corresponding field name 
to search.

Properties
Table 13 lists the Find Field object properties.

Table 13. Find Field Object Properties

Property Required Description

Display Name Optional The text (or key to localized text) that will be displayed for this find field 
when its parent Find object definition is active in the Search Center 
window.

Field Required The field being searched in the business component.

Name Required Name of the search field added.

Sequence Optional The position of this find field in the list of fields displayed in the Search 
Center-Find category for the parent find object definition.

Title Optional Reserved for future use.

Display in 
Results

Optional Checking this option allows the field to be displayed on the find results 
applet in the Search Center. By default the whole field value will be 
displayed. But you can set a limit so that characters after the max length 
will be skipped and you will see an ellipsis (...) in the end. You need to 
use the user property in Find Results List Applet to set the length limit. 
Use the following applet user properties. 

■ User Property Name: [Find Object Name]

■ User Property Value: [Find Field] = [Length]

or if more than one,

■ User Property Value: [Find Field Name] = [Length], [Find Field 
Name] = [Length], [Find Field Name] = [Length] ... 

Display in Entry Optional Checking this option allows the field to be displayed on the find entry 
applet in the Search Center.
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Rules and Assumptions
■ The field specified in a find field must be a field that exists in the business 

component for the applet for the find object definition.

■ The Search Center-Find category and a query by example (QBE) can have 
different behavior for multi-value fields because the Search Center will generate 
the same query as if you did an EXISTS query on the field in QBE. You can verify 
this by embedding your QBE expression with Exists(), for example (Aga*).

■ QBE supports both types of querying, but to keep the Search Center simple, 
Siebel applications implement a query that works in all cases. This query uses 
the syntax Ada*, where the wildcard, as indicated by an asterisk (*) is appended 
to the search text. If you want to mimic the behavior of the non-Exists version 
with the Search Center-Find category, you should create a join from the primary 
ID field for the MVLink to the table containing the data. Then add a field on the 
table you joined to and point your find field to this new field. This change will 
cause the query to use the syntax EXISTS (Ada*).

■ If you want to do an exact search in a Find field, prefix the search text with an 
equal sign (=) sign. For example, = Ada. The query uses the syntax = Ada. 
(No wildcard is appended to the text).
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Find View Object
Each Find view object definition specifies a view that may be activated when the 
parent find is initiated from the Search Center. Each find view specifies with a 
different visibility level for the same business component. The views are tried in a 
fixed order, as specified in the Sequence property of the Find view object, until a 
view is encountered in which the user can see data. The visibility for this view is 
then applied to the results from the query on the Find object. 

For a given user, the find operation will use the first find view object definition that 
is in the user’s responsibility list. Because different views apply different visibility, 
you would have the least restrictive views first in the list and the most restrictive 
last. This order allows users with different responsibilities to find items using the 
most broad visibility that they have access to use. 

Properties
Table 14 lists the Find View object properties.

Table 14. Find View Object Properties

Property Required Description Comments

Sequence Optional The order that views are to be considered 
for usage for the find object definition.

View Required The name of the view to be used for the find 
operation when this find view is used.
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Find Field Locale Object
Locale objects are children of Find Field objects and contain all translatable 
information. Locale objects represent language-specific overrides used with the 
Find Field object type.

Properties
Table 15 lists the Find Field Locale object properties.

Find Locale Object
Find Locale objects are children of UI objects and contain all translatable 
information. They represent the language-specific overrides with the Find object 
type.

Properties
Table 16 lists the Find Locale object properties.

Table 15. Find Field Locale Object Properties

Property Required Description Comments

Display Name Optional The text or (key to localized text) that will 
be displayed for this find field when its 
parent find object definition is active in the 
Search Center.

Name Required The abbreviation of the language being 
used. 

For example, ENU=U.S. 
English.

Table 16. Find Locale Object Properties

Property Required Description Comments

Display Name Optional

Name Required The abbreviation of the language being 
used. 

For example, ENU=U.S. 
English.
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Find Pick View Object
Users can associate search results from the search center to the active record in the 
top applet in the main content area. The Pick View object, located under Search 
Category > Search Pick View > Find > Find Pick View, identifies the applet that 
can receive the selected item from the Search Results List as an associated record. 
This applies only to applets that can handle such associations.

For more information see “Creating Search or Find Pick Views” on page 79. 

Properties
Table 17 lists the Find Pick View object properties.

Table 17. Find Pick View Object Properties

Property Required Description Comments

Applet Name Optional Name of the applet

Field Name Optional Name of the view containing the applet

Name Required Logical name of the pick view

View Name Required Name of the view containing the applet

Property Field 
Name

Optional Name of the multi-value group field that 
will receive the search result
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Advance Configuration of Search Operations
Each Siebel application contains preconfigured Siebel Tools Objects that allow you 
to build search indices so users can perform searches. A number of additional Siebel 
Tools objects allow you to customize and further enhance your searching 
capabilities. These objects, and their functions are described below.

Associating Search Categories to New Search Definitions
Identify all search categories that you want to expose in your application and 
associate them to the appropriate search definition. Also, specify the filter search 
spec for each search category.

To associate search categories to a search definition

1 Add the required search categories to the search definition.

For example, the Call Center Application uses the search definition Call Center 
Definition. Some of the search categories exposed in this application include 
Catalog Category, External Document, Literature, Product, and so on.

2 Optionally, you may specify an appropriate filter search specification for each 
category. 

For example, for the search category Product in the Call Center Definition to 
restrict product search results by the Catalog Type of Buying, you may want to 
specify a filter search specification like the following:
[Catalog Type]<>LookupValue(‘CTLG_TYPE’, ‘Buying’)

NOTE: The filter field Catalog Type needs to be already defined as a filter field for 
the associated search index. See “Creating Search Filter Fields” on page 84 for 
information.
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Using Child Business Components as the Base Business Component 
for Find or Search Categories

This feature allows you to drilldown to a view that is not displaying the search 
object buscomp as primary. Therefore, it is possible to base a search index or find 
category on a business component used as the child applet for the drilldown view. 
For example, a search category could be based on Service Request Attachments and 
the drilldown view, be the Service Request attachment view. In this case, the 
following logic would be applied when the result is drilled into:

1 Retrieve the business object of the drilldown view defined for the find or search 
category.

2 Determine the business component hierarchy from the business object. Find the 
unique ID (for example, SR ID) for the parent buscomp (Service Request) on the 
drilldown view by pulling from the child business component upon which the 
search or find category is based (Service Request Attachment).

3 Set the search spec using that unique ID for that parent business component and 
drilldown to that view.

Creating Search or Find Pick Views
Users can associate search results from the search center to the active record in the 
top applet in the main content area. The Pick View object, located under Search 
Category > Search Pick View, identifies the applet that can receive the selected item 
from the Search Results List as an associated record. This applies only to applets 
that can handle such associations.

In order to attach a record in the Search Results List Applet or Find Results List 
Applet to an active parent object in the Content Area, the relationship between the 
record and the applet must be many-to-many. In Siebel Tools, this relationship is 
implemented by creating a link between the two Business Components with an 
intersectional table. If you check a Business Object and find out that a Search 
Category or Find Object is one of its Business Components and there is an many-to-
many link between them, it is permissible to attach this result row to an object. 

This association happens in the Business Object Layer, in terms of Siebel Three-
Level Architecture. But to support the user to go to a view directly to verify the 
association, there is a requirement that Pick View be added to the Search Category 
Object or Find Object. This Pick View defines the view that users can go to after 
association happens, as well as the candidate association. You will need to add new 
Pick Views in order to add this Search Category or Find Object to a Business Object.
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Properties
Table 18 lists the properties for the Pick View object.

To create pick views

1 Lock the project that will contain the Pick View object you want to add.

2 In the Object Explorer choose Search Category > Search Pick View.

A new record appears.

3 Enter the required property values for the new record.

4 To commit your changes, click anywhere outside the modified row, or move 
outside the row using the up and down arrow keys.

5 Compile your changes to the SRF file.

Table 18. Pick View Object Properties

Properties Required Description Comments

Applet Required Name of the applet

View Required Name of the view containing the applet

Name Required Logical name of the pick view

Destination 
Field

Optional Name of the multi-value group field that 
will receive the search result 
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Creating Preview Views
In order for a user to preview a result record, the Preview view must be defined. 
You define the Preview in the Search Category Object or Find Object. The view will 
show up in a pop-up browser when the user clicks on the Preview button. Siebel 
Search does not support any navigation in the pop-up Preview view. The Preview 
view is read-only with no navigation buttons. 

To create a preview view

1 Lock the project that will contain the Preview View object you want to add.

2 Choose an existing applet that best fits your preview purpose.

This applet should be a Form Applet.

3 Create a Base type Applet Web Template and comment it as being for Search 
Preview.

4 Map Data type Controls to Applet Web Template Items. 

Do not map any button type controls that are command controls.

5 Configure a new view, and associate the applet in Base mode to your new view.

6 Add responsibility and license key for this new view.

7 Associate this view to a screen that will exist in the application where you are 
running Search Center.

You do not need to provide Viewbar Text and Menu Text.

8 Compile your changes to the SRF file.
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Adding New Result Fields
Siebel Search is installed with a default set of Search Engine Result Fields. If you 
have a requirement for more result fields, make sure that the following rules and 
assumptions are adhered to.

Rules and Assumptions
■ All fields defined will be created for all the Search Tables belonging to the parent 

search engine. 

■ Result Fields that are marked System or Data (Public) can be customized. See 
“Creating Custom Result Fields” on page 83 below for more information.

To add new result fields

1 Lock the project that will contain the object you want to add.

2 Select Search Engine > Search Result Field in the Object Explorer. 

3 Click in the Object List Editor window to make it active. 

4 Choose Edit > New Record.

A new record appears.

5 Enter property values in the new row in the Object List Editor. 

See “The Search Result Field Object” on page 56 for a list of Result Field Object 
properties.

6 To commit your changes, click anywhere outside the modified row (or move 
outside the row with the up and down arrow keys).

7 Compile your changes to the SRF file.
82 Siebel Search Administration Guide MidMarket Edition Version 7.5



Siebel Search Configuration Using Siebel Tools

Advance Configuration of Search Operations
Creating Custom Result Fields
You can customize certain properties for results fields. For example, for Call Center 
Definition you may want to allow searching on Summary and Document Text result 
fields, but for eService Definition you may want to allow searching only on 
Document Text. 

Other ways to customize search result fields are as follows:

■ To be Used in Search, meaning the specified search keyword will be searched 
against these columns.

■ To be Visible in the search results applet.

■ To be displayed with a different Display Name, Widths or Text Alignment.

■ To use a different Display Format or Scaling Factor.

Properties
Table 19 lists the properties for the Search Custom Result Field object.

Table 19. Search Custom Result Field Object Properties

Display Name Required Description Comments

Display Name Optional The name to display in the user interface Can be overridden

Display Format Optional The format mask to apply to the data Can be overridden

Name Required The logical name of the field

Scaling Factor Optional The multiplication factor for numeric 
columns

Can be overridden

Sequence Required The order in which columns should appear Can be overridden

Text Alignment Optional The alignment of the text in the column Can be overridden

Use in Search Optional Indicates if this column is to be included in 
a search

Can be overridden

Visible Optional Value is TRUE or FALSE; if TRUE, the field 
is displayed

Can be overridden

Width Required The width, in pixels, of the display column Can be overridden
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To create custom results fields

1 Lock the project that will contain the object you want to add.

2 In the Object Explorer window, select Search Engine > Search Definition > 
Search Custom Result Field.

3 In the Object List Editor, choose Edit > New Record.

4 Enter the required property values.

5 To commit your changes, click anywhere outside the modified row, or move 
outside the row with the up and down arrow keys.

6 Compile your changes to the SRF file.

Creating Search Filter Fields
Filter fields are special fields that are used to constrain search results for a search 
category. To configure search time filter fields for a search index, you need to 
identify buscomp fields that can be used to filter results. For example, searching 
against the search index Literature would retrieve all literature records that match 
the search query. But to restrict the search results to Literature records that are of 
the type Brochure, you need to define filter fields.

Siebel Search only supports indexing text and date fields (numeric fields are not 
supported) and you should only map buscomp fields that are of type DTYPE_TEXT, 
DTYPE_UTCDATETIME, DTYPE_DATETIME, UTC_DATE to filter columns. 

For a list of supported syntax elements for filter search specifications, see 
Appendix C, “Syntax For Filter Search Specifications.”
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Business Component Fields that can be used as filter fields are as follows:

■ Map buscomp fields that have static pick lists associated to them. Since the 
intention is to constrain search results, these types of fields make the most sense 
to use as filter fields. For example, in the Literature buscomp field Sales Tool 
Type is associated to a pick list that has an LOV called SALES_TOOL_TYPE. 

■ Map buscomp fields that are flags. For example, in the Solution buscomp, the 
field Publish External is a flag that indicates if the Solution can be published 
externally. Search results can be restricted to only those solutions that have the 
flag set to TRUE.

■ Map buscomp fields that are Dates. For example, the Solution buscomp, Created 
is a UTCDATETIME field. 

Rules and Assumptions
■ Filter fields are created as columns, only for the parent search table, unlike 

Result Fields that are created for all the search tables. For example, only FUL_LIT 
will contain the column SALES_TOOL_TYPE that represents the buscomp field 
Sales Tool Type.

■ You must also specify the column name that will be used in the index table along 
with the index mode, data type, text length, and sequence. 

■ The BC Field can be text or date fields.

■ For text fields, the Data Type attribute must be Character or Varchar. The 
index Mode can be Literal, Normal or None. The Text Length can be an 
appropriate length that is equal to or greater than the length defined for the 
database column. 

■ For date field, the Data Type attribute must be set to Date and the index mode 
must be set to Value. The Text Length field need not be specified. Users 
should only pick a BC field that is of type Datetime, Date, or UTCDateTime. 
If you specify any other field as a date filter field, at index time you will get 
an error. This rule is enforced to make sure that users do not accidently map 
a character or numeric field to a Fulcrum date column.

NOTE: Numeric fields are not supported.
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Using Search Filters in Filter Search Specs
At search time results can be constrained implicitly through a filter search spec. This 
is typically defined under Search Engine > Search Definition > Search Definition 
Category object. 

For text fields an example of filter search spec is as follows. For the search category 
Literature in the Call Center Definition, to restrict literature search results implicitly, 
by the Sales Tool Type of Brochure, you may want to specify a filter search 
specification like the following: [Sales Tool 
Type]=LookupValue('SALES_TOOL_TYPE', 'Brochure'). 

For information on Search filter syntax, see Appendix C, “Syntax For Filter Search 
Specifications.”

For date fields, an example of filter search spec is as follows. To restrict results to 
only those items, such as quotes, whose Close date is less than today’s date, you 
may want to specify a filter search specification such as: [Close Day] <= Today ().

NOTE: Hummingbird Search Server does not support indexing time fields, so if you 
index a datetime column the time part would be ignored.

Supported comparison operators are =, <>, <, >, <=, >. Other supported 
functions include the Today() function. You can also specify Today() + or - a certain 
number of days. For example, you could add the following to the Search Spec: 
[Close Date]<= Today() + 10. As always multiple filter search spec can be joined 
together by AND, OR, and NOT. 
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Table 20 lists search filter field object properties. 

Using Search Filter Fields on the Search Center UI
Filter fields can also be exposed on the UI to allow users to control the search results 
that get returned. Certain search indices like Solution, Literature, Service Requests, 
come exposed with filter fields in the preconfigured state. Filter fields will appear 
on the UI as various UI controls like drop-down lists, check boxes, pick lists, text 
box, and date controls. 

In addition, for certain search categories like Solution, Literature, Service Request, 
and Product; filter fields are exposed on the UI along with the Keywords control. 
This allows the user to refine their searches to a subset of records. For example, the 
Catalog Category field is exposed as a filter field on the UI. Users can search for the 
keyword Dell Computers only in the Catalog Category called Personal Computer. 

To expose new filter fields in the Search Center, there are three major steps which 
you need to follow, which are listed below. The steps are Search Configuration, 
Search Administration, and Search Execution.

Table 20. Search Filter Field Object Properties

Property Required Description Comments

Name 
(Buscomp 
Field)

Required The active fields of the buscomp that is 
associated with the parent Search Index 
object.

These fields will be included 
in the search merely as filters.

Column Name Required The name of the physical column in the 
search index which varies with the vendor 
of your database software.

Data Type Optional Specifies the data type of the column. Valid 
values are varchar and char.

Index Mode Optional Specifies the index mode of the column. 
Valid values are literal, none, and normal.

The index mode specifies the 
type of indexing that is 
applied on the values in this 
field.

Sequence Required

Text Length Optional The amount of storage, in bytes, allocated 
to a field.
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Search Configuration
The configuration steps that need to be done to expose filter fields in the Search 
Center are listed below.

1 Determine the search category for which you want to expose filter fields.

For this example, assume you want to expose the date field Created for the 
Solution (Call Center) search category. 

2 Define the filter fields for the search index. 

You would create a filter field called Created in the underlying search index 
Solution.

3 Check out the Search Execution or a relevant project in Tools, and create a copy 
of the Search Entry virtual business component to create your own custom 
business component. 

For example, you would choose the Solution Search Entry buscomp. Retain the 
base fields like SearchText, Category, and SelectedSearchCategory.

4 Add filter fields to this buscomp. 

The fields should be named the same as the filter fields for the Search Category 
that you plan to customize. 

■ For example, add a field called Created to the buscomp. Since this is a date 
field set the Type to DTYPE_UTCDATETIME.

If the category uses Catalog Category visibility then it may also be a good idea 
to expose the Catalog Category field on the UI. 

NOTE: Even though Catalog Category field is not really a filter field, it can still 
be exposed on the UI, as long as the search index includes this field in the 
index field map. 

■ For the example, Solution Search Entry already exposes this field.
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5 You now need to create special filter applet (if one does not already exist). 

The filter applet will be used in the place of the Basic Search Applet or Basic 
Search Applet (DotCom), depending on which application type this special 
applet is exposed. Use the DotCom version of the applet for customer 
applications and the other one for High Interactivity or Standard Interactivity 
applications. A copy of the Basic Search Applet or Basic Search Applet (DotCom) 
can be made for this purpose. This applet will have the filter fields exposed as 
some UI control, apart from the Keyword control, to allow the user to enter 
values.

a For the example, you will use the Solution Search Applet that is based on the 
Solution Search Entry buscomp that you modified in the previous step. 

b Then add a control based on the new BC field Created that was created in the 
previous step. The applet should expose the Keywords control as well.

c Since Created is a date field, the Runtime attribute should be set to TRUE. 
This will draw the date picker control. 

d You must also map the Control to an Applet Web Template Item.

6 Define this applet as a Toggle applet for the Basic Search Applet or Basic Search 
Applet (DotCom) and add the following values. 

■ Name: Solution Search Entry Applet (or some unique name). 

■ Applet: Solution Search Entry Applet. 

■ Auto Toggle Field: SelectedSearchCategory (It is important to retain this field 
in the BC).

■ Auto Toggle Value: Solution (Call Center) - The name of the search category 
that is defined in Tools.

NOTE: Based on the search category the user chooses at run time, the toggle 
applet whose Auto Toggle Value matches the search category currently 
chosen will appear.
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7 Add the new business component you just created to the Search Execution 
business object. 

If you do not complete this step, you will get an error when accessing this search 
category in the Search Center.

8 Now compile the changes to the SRF and use this new SRF in your application. 

Search Administration
If you added a new search filter field in the previous steps, then you have to perform 
the following steps.

1 Create a new Search Index.

Whenever you add a new filter field, you are changing the schema of the 
Hummingbird table. Therefore the index has to be created again. Make sure that 
you have the right settings defined. It is important to choose the right Translation 
Table value depending on whether you connect to a Unicode or a code page 
database. For information on creating new search indices, see “Working with 
Indices” on page 101. 

2 Index the category to which you added the filter field. For information on 
generating indices, see “Working with Indices” on page 101.

3 Navigate to Search Administration > Advanced Search Settings. 

Make sure the settings defined for the default language are correct. This 
information will be used at search time.
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Search Execution
To test the filter fields at run time follow the following steps.

1 Open up the application, that uses the search category for which you added the 
filter fields, then open the Search Center. 

2 Choose the search category for which you created a special applet in Tools. The 
special filter fields + the keyword field should now be visible. If the search 
category uses Access Control visibility the Catalog Category field may also be 
visible depending on whether it is mapped.

In the example, you would open the Call Center application and then pick the 
Solution option. The special filter applet should appear with the Created field 
exposed on the UI.

3 Enter values in the fields, and then click Search. 

Enter the text you want to search for in the Keywords field and values in the 
other fields that may be used to filter the search results. For example, you may 
want to restrict the results to a particular Catalog Category. You would enter, as 
an example, a date value like > 12/12/01 in the Created field, then enter any 
keyword like motors, and click Search. 

The results that come back should contain the keyword you look for and also be 
constrained by the filter values.

All solutions with the Created date > than the mentioned date and with the 
keyword motors will be returned.

Notes
■ If the filter fields exposed on the UI are also used in the filter search spec, the UI 

values will be ignored. The filter search spec always takes precedence over the 
UI filters.

■ UI filter fields cannot be exposed for advanced search category. 

■ Boolean searches are not supported on filter fields. For example, entering a 
search keyword like Installation AND Upgrade in the filter field is not supported.
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This chapter describes how to administer Siebel Search under your Windows 
system. Using the procedures provided in this chapter, you will be able to define 
and change your index creation settings, administer your indices, allow mobile 
users to synchronize updated indices to their local databases, and administer search 
execution settings.
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Preadministration Checklist
Before you proceed with administration, you may want to decide on the following 
issues. A column is provided for your answers.

Question Response

What do you want to search? Database tables and 
external documents? 

If searching on database tables, what are the names 
of the tables and the business components?

If searching on external documents, what is the 
location of the file server holding the external 
documents and the name of the highest-level 
directory containing those documents? 

What are names of the Siebel database tables that 
you want to search and their location on the 
network?

What configuration changes (if any) you plan to 
make to Hummingbird?

Will you be installing Siebel Search for mobile client 
in disconnected mode?
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Index Settings
You define and change index creation settings from the Index Settings Search 
Administration screen. Index settings are explained in the following section. 

To create an index setting

1 Navigate to Search Administration > Index Settings.

2 From the Index Setting Properties menu, select New Record.

3 Click in the Name field to make the field active, and then from the drop-down 
list, choose the appropriate type of index setting. 

4 Click in the Value field, enter the appropriate value, and then click Save.

Normalization Setting
This setting selects the case normalization strategy to use when indexing the data 
in the table. Normalization is always performed on the data after it is translated to 
Unicode. The value specified can be DEFAULT (lowercase letters are mapped onto 
uppercase letters) or NONE (no case normalization mapping is done).

Example

Property: Normalization

Value: DEFAULT (or NONE)

To create the normalization setting

1 Navigate to Search Administration > Index Settings. 

2 In the Index Setting Properties view, click on the Normalization record.

The Index Setting Properties list appears. 

3 From the Name drop-down list, select Normalization.

4 From the Value drop-down list, select the appropriate normalization setting, 
then click Save.
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Translation Table Setting
This setting specifies the translation table the SearchServer database text reader 
applies to data obtained from the database. When indexing Unicode databases this 
setting is ignored. When indexing code page databases, use Table 22 on page 100 
for values. 

Example

Property: Translation Table

Value: WIN_LATIN1

To change translation table settings

1 Navigate to Search Administration > Index Settings. 

2 In the Index Settings Properties view, click in the Translation Table row to make 
the row active.

3 From the drop-down list in the Value column, select the appropriate Translation 
Table setting, and then click Save.
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Hummingbird Stop File Setting
This setting specifies an operating system file that contains a list of words not to be 
indexed. Typically, these are words with little semantic value. Use of the Stop File 
can significantly reduce the size of indices by removing words that are not useful 
for searching. For example, prepositions and articles can be safely removed from 
indices in most cases. 

The stop file is assumed to be in the directory where the table configuration is 
created unless the stop file name is a fully qualified path name. The default value, 
an empty string, specifies that no stop file is used. In this case, SearchServer 
provides a stop file called FULTEXT.STP, which can be used by explicitly specifying 
it in this parameter. The default stop file contains the following words:

after, also, an and, as, at, be, because, before, between, but, by, for, from, 
however, if, in into, of, or, other, out, since, such, than, that, the, there, these, this, 
those, to, under, upon, when, where, whether, which, with, within, without.

The stop file can contain a maximum of 1,024 stop words totaling not more than 
10,000 characters. The stop file is a text file that can be edited in Notepad, or any 
other plain-text editor. 

To customize the stop file, open it in a text editor, directly modify it, then save it 
using the same name. 

CAUTION: If you choose to customize the stop file after you have created an index, 
you must regenerate all indices associated with that particular stop file. Also, if you 
are supporting Mobile Client searching, you need to remove the absolute path and 
leave only the stop file name fultext.stp, and make sure that the stop file is in the 
index directory (index directory/siebelroot/search/{datasource}/index/).
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Usually, you specify a stop file that is appropriate for the language of the documents 
you are indexing. SearchServer provides several stop files which are listed in 
Table 21.

Table 21. Hummingbird SearchServer Stop Files

SearchServer Stop File Explanation

csource.stp Used with the C-language Source Code text reader.

fulfra.stp Uses the multi-lingual unicode parser with default 
options, and contains French-language stop words.

fultext.stp Uses the multi-lingual unicode parser with default 
options, and contains English-language stop words. 

ixkor.stp Uses the InXight-based ixasian parser for Korean-
language text.

ixjap.stp Uses the InXight-based ixasian parser for Japanese-
language text.

ixschi.stp Uses the InXight-based ixasian parser for simplified 
Chinese-language text. 

ixchi Uses the InXight-based ixasian parser for traditional 
Chinese-language text.

japan.stp Included to support old collections. fultext.stp is used 
to support Japanese-language text. This file is empty.

korean.stp Used for Korean-language text using n-grams. The 
Unicode parser is used with k=1 set to map han 
characters to hangul.

wspprox.stp Used when indexing with support for Word, 
Sentence, and Paragraph Proximity.
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Example

Property: Stop File

Value: C:\Program Files\HUMMINGBIRD\fultext\fultext.stp

To change the stop file location

1 Navigate to Search Administration > Index Settings. 

2 In the Index Setting Properties list, select Stopfile, and then click in the Value 
column to make the row active.

3 Change the value to match your stop file path, and then click Save.

Text Reader Setting
The Text Reader setting is important if you are going to be indexing external 
documents. Hummingbird SearchServer provides text readers that allow you to 
access documents stored in most formats. If you have file formats that are not 
supported by the provided text reader, it is possible to build custom text readers. For 
information on creating custom text readers, see the Hummingbird documentation. 

NOTE: Under most circumstances, the default text reader can be used. In this case, 
if no text reader setting is entered, this default text reader will be used.

Table Language Setting
Specifies the language the table is created in, so that linguistic processing package 
associated to the language can expand the nuances of terms and phrases particular 
to that language.
Version 7.5 Siebel Search Administration Guide MidMarket Edition 99



Administration of Siebel Search

Index Settings
In Search Server 5.0, stemming is done at index time. Since stems are generated 
only for a particular language this setting should be used only when the table that 
is being indexed contains words predominantly from one language. You need to 
decide upon setup. Not setting this parameter implies word stemming is disabled 
and hence stems will not be generated. 

NOTE: Since Unicode databases could have records in several languages, this 
parameter will not be turned on in the preconfigured setting. 

Example

Setting: Table Language

Value: ENGLISH

Sample Database Index Setting Values
Table 22 lists the default values for Index Settings in the sample database.

Table 22. Sample Database Index Setting Values

Index Setting Value

Normalization DEFAULT.

Stopfile D:\Program Files\Hummingbird\SearchServer 
5.0\fultext\fultext.stp.

Translation Table Win_1252. 
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Working with Indices
You create and update search indices from the Search Indices View. You define new 
search indices in Siebel Tools. For instructions on defining new search indices, see 
“The Search Index” on page 58. The Search Indices View consists of two lists. The 
primary list includes all index settings that you previously created. The secondary 
lists displays all the search indices which may be administered. 

NOTE: After indexing a database, or external documents, it is advisable to navigate 
to your temp directory and delete files for optimal performance.

CAUTION: The index building operation should be allowed to finish. You should not 
stop the operation at its midpoint. Once ExecSQL completes the index building 
operation, results will be returned. Response time for an indexing operation is 
positively correlated with the size of your index. 

To index a search index

1 Navigate to Search Administration > Search Indices.

2 In the Index Settings list, select the Index Setting that you would like to use for 
creating the Search Index.

3 In the Search Index view, click in the row containing the index.

4 Click the Index button.

A pop-up window appears for the duration of the indexing operation. 

NOTE: When a Siebel Server starts, it caches information about the available indices 
and will not automatically reset its cached list of search categories when a new 
index is subsequently created. When creating new indices, the Reset Categories 
menu item should be chosen from the applet menu on the Search Admin Settings 
List Applet (Read Only) applet in the Search Indices View. This action resets the 
cached list of categories for the current Siebel Server. This must be done on all 
servers in the enterprise.
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To refresh an index

1 Navigate to Search Administration > Search Indices.

2 In the Index Settings list, select the Index Setting that you would like to use for 
creating the Search Index.

3 In the Search Index view, click in the row containing the index. 

4 Click the Refresh button.

To refresh all indices

1 Navigate to Search Administration > Search Indices.

2 In the Index Settings list, select the Index Setting that you would like to use for 
creating the Search Index.

3 In the Search Index view, click in the row containing the index.

4 Click the Refresh All button.

Automating the Process of Refreshing Indices

To create a workflow process to Refresh or Refresh All

1 Navigate to Business Process Administration > Workflow Processes. 

2 Create a new Workflow Process based on the Search Administration Business 
Object.

3 Navigate to the Process Designer for the new process you created. 

a Within the Designer, create a workflow that includes a Business Service 
object. After you have added a Business Service graphic to the designer, 
double-click on the graphic to drill into the Business Service instance. 

To configure the Business Service, you will need to do the following:

b Enter Search Admin Service in the Business Service field.
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c Enter Refresh Index or Refresh All in the Method field.

If you selected Refresh Index, you will need to add two arguments in the 
Input Arguments applet in this view. 

d Index Setting. This is the name of the Index Setting you wish to use for the 
Refresh. For this argument the Type should be Literal and the Value should 
be the name of your setting.

e Index Name. This is the name of the index you wish to refresh. For this 
argument, the Type should be Literal and the Value should be the name of 
the index, such as Solution.

If you selected Refresh All, you will need to add one argument in the Input 
Arguments applet in this view.

4 Return to the All Processes tab within the Workflow Processes view. Click on the 
Activate button.

Troubleshooting 
You can test your workflow by clicking on the Process Simulator view tab and 
running though the Workflow Process you created. You can verify that the index 
was refreshed by checking the Updated field in the Search Indices view for a given 
index, or by checking the new .log file in the Siebel/search/ServerDataSrc/index 
directory. For more information about the success of the indexing process, you can 
check the .dil file in the Siebel/search/ServerDataSrc/scripts directory.
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Setting Up Your Workflow Process to Run Periodically
One way to configure your Workflow Process to run on a periodic basis is to set up 
a Repeating Component Request that starts your Workflow Process at specific time 
intervals.

To set up periodic workflow processes

1 Navigate to Server Component Requests > Repeating Component Requests.

2 Create a new Server Component Request. 

a Enter Workflow Process Manager in the Component/Job field.

b Enter your desired Repeat Interval and Repeat Unit in the detail applet. For 
example, a Repeat Unit of Weeks and a Repeat Interval of 1 would run your 
Workflow Process on a weekly basis.

3 In the Component Request Parameters view, create a new parameter. 

a In the Name field, select Workflow Process Name, and in the Value field, 
enter the name of the Workflow Process you wish to run periodically.

4 Click the Submit Repeating Job button in the Repeating Component Request 
view.

Troubleshooting
To check the status of your Repeating Component Request, or to see if any errors 
occurred while the Component Request was running, navigate to Server Component 
Requests > My Repeating Component Requests Detail. The My Repeating 
Component Requests Detail view within this screen shows the status of a given 
Component Request. If any errors have occurred during execution of the 
Component Request, you can get more detailed information about the error in the 
WfProcMgr log file in the Siebel/log directory. 
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Synchronizing Indices on the Mobile Web Client
To allow synchronization of indices onto the mobile client machine you must enable 
downloading from the Mobile Search Administration view. This process, detailed 
below, need only be done once for each search index. 

NOTE: The appropriate size of the index is listed in bytes in the Index Size column 
of the Mobile Administration screen. The index size and connection speed affects 
synchronizing indices. 

To synchronize indices onto a mobile client

1 Navigate to Search Administration > Mobile Search Administration.

2 In the Download column, check each index you would like to download to the 
mobile client machine.

3 Synchronize the database against the Search Server.

4 Return to the Mobile Search Administration screen.

5 From the Mobile Administration menu, choose Uncompress.
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Search Execution Settings
You define basic search properties from the Basic Settings view. You have different 
settings for each language. There is one default setting per language. When you are 
in the Search Administration screens, you access this view from the Show drop-
down list. 

Check Document Status Setting
This setting specifies if the timestamps of your external documents are checked 
against FT_MTIME before the data is retrieved. This statement can be used to 
improve retrieval performance for tables on CD-ROM or tables that are specified as 
read-only. This statement has an effect only on the external document timestamp 
checking and not on timestamp checking of other columns. 

The default value of this setting is TRUE, meaning timestamps are checked on 
external documents. Setting this value to FALSE turns off the timestamp check. 

Example

Property: Check Document Status

Value: TRUE

To create the Check Document Status setting

1 Navigate to Search Administration > Basic Settings.

2 From the Settings Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Check Document Status. 

4 Click in the Value column of the new row, and from the drop-down list, select 
TRUE to enable timestamp checking of external documents, or select FALSE to 
disable the function, and then click Save. 
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Collation Sequence Setting
This setting specifies the name of a collation function that is used to determine the 
ordering of character strings. The default collation sequence provides dictionary 
ordering for English and French text being returned by most languages based on 
Latin 1.

NOTE: Humingbird supports all of the locales listed below. Siebel MidMarket Edition 
only supports English, German, Spanish, Italian, French, Brazilian Portuguese. 

Example

Property: Collation Sequence

Value: DICTIONARY_LATIN1

In Windows 32-bit environments, the following collation sequences are included in 
the fultext.ftc system configuration file. You can use any of them by specifying the 
name in the SET COLLATION_SEQUENCE statement. They all require that their 
respective locale be installed on the Windows system. 

All supported locales are listed below.

■ AFRIKAANS ■ BASQUE

■ CATALAN ■ DANISH

■ DUTCH ■ DUTCH_BELGIAN

■ ENGLISH_USA ■ ENGLISH_UK

■ ENGLISH_CANADIAN ■ ENGLISH_NEW_ZEALAND

■ ENGLISH_AUSTRALIAN ■ ENGLISH_IRELAND

■ ENGLISH_SOUTH_AFRICAN ■ FINNISH

■ FRENCH ■ FRENCH_BELGIAN

■ FRENCH_SWISS ■ FRENCH_CANADIAN

■ FRENCH_LUXEMBOURG ■ GERMAN

■ GERMAN_SWISS ■ GERMAN_AUSTRIAN

■ GERMAN_LUXEMBOURG ■ GERMAN_LIECHTENSTEIN
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To create collation sequence setting

1 Navigate to Search Administration > Basic Settings.

2 From the Setting Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Collation Sequence. 

4 Click in the Value column of the new row, and in the text box, enter the 
Dictionary value, and then click Save. 

Max Exec Time Setting
This setting specifies the maximum execution time, in milliseconds, for searches. 
The numeric value that is specified can be rounded up to the nearest second 
depending on the your operating system.

Setting this value permits an application to stop these statements from executing for 
a long period of time. These are the only statements that are executed in stages, and 
the only statements that are affected by the SET MAX_EXEC_TIME statement.

The default value is 0, which allows SearchServer to execute for an unlimited 
amount of time.

Example

■ ICELANDIC ■ INDONESIAN

■ ITALIAN ■ ITALIAN_SWISS

■ JAPAN_EUC ■ JAPAN_SJS

■ JAPAN_UTF8 ■ KOREA_87

■ KOREA_UTF8 ■ NORWEGIAN_BOKMAL

■ NORWEGIAN_NYNORSK ■ PORTUGUESE

■ PORTUGUESE_BRAZILIAN ■ SPANISH_MEXICAN

■ SPANISH ■ SPANISH_MODERN

■ SWEDISH
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Property: Max Exec Time

Value: 200

To create max exec time setting

1 Navigate to Search Administration > Basic Settings.

2 From the Setting Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Max Exec Time. 

4 Click in the Value column of the new row, and in the text box, enter the 
maximum search time value, and then click Save.

Max Search Rows Setting
This setting specifies the maximum number of rows to be included in a working 
table. Setting this value permits an application to stop very general searches from 
returning too many rows. For example, you can limit the search so that it retrieves 
only 10 result rows. The default value is 0, which allows SearchServer to retrieve an 
unlimited number of rows. 

Example

Property: Max Search Rows

Value: 500

To create max search rows setting

1 Navigate to Search Administration > Basic Settings.

2 From the Setting Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Max Search Rows. 
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4 Click in the Value column of the new row, and in the text box, enter the 
maximum rows searched, and then click Save. 

Server Report Time Setting
This setting specifies the maximum interval (in milliseconds), during which a 
SearchServer API function will be permitted to execute before returning control to 
the application. The numeric value that is specified can be rounded up to the 
nearest second, depending on the operating system. 

Example

Property: Server Report Time

Value: 200

To create server report time setting

1 Navigate to Search Administration > Basic Settings.

2 From the Setting Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Server Report Time. 

4 Click in the Value column of the new row, and in the text box, enter the server 
report time value, and then click Save. 
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Search Term Separator Setting
This setting specifies the default search term separator to be used. Valid values for 
this setting are AND or OR. 

Example

Property: Search Term Separator

Value: OR

To create search term separator setting

1 Navigate to Search Administration > Basic Settings.

2 From the Setting Properties menu, select New Record. 

A new row appears in the Setting Properties list.

3 Click in the Name column of the new row, and from the drop-down list, select 
Search Term Separator.

4 Click in the Value column of the new row, and in the text box, enter the value 
AND or OR, and then click Save. 

Sample Database Values for Basic Search Settings
Table 23 lists the default values for Basic Search Settings in the sample database.

Table 23. Sample Database Index Setting Values

Setting Name Value

Setting Name Value

Character Set UTF8

Max Search Rows 500

Normalization DEFAULT

Relevance Method 2:1

Search Term Separator OR
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This section provides information on Siebel Search Environmental Variables.
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Siebel Environmental Variables
Table 24 lists the environmental variables required for a implementation of Siebel 
Search. There are no ODBC drivers used in a Windows implementation, and thus 
no data source information is made implicit. All control parameters that are 
normally specified in the data source must be defined as environmental variables. 
These are FULSEARCH, FULCREATE, FULTEMP, and optionally, FTNPATH. 

Although these variables are called Siebel Environmental Variables, they are used 
by Hummingbird SearchServer itself. 

The following are examples of how these Hummingbird environment variables can 
be set. It is assumed any Siebel installations are located in the C:\SIEBEL70 
directory.

Search Server Configuration. If you configure your Siebel Server as Search Server, the 
following parameters will be set:

■ FULCREATE: 
C:\SIEBEL70\search\ServerDataSrc\index

■ FULSEARCH: 
C:\program files\fulcrum\fultext;C:\SIEBEL70\search\ServerDataSrc\index

Table 24. Siebel Environmental Variables

Environmental 
Variable Environmental Variable Definition

FULCREATE This is the location that was specified in the Pre-Installation Checklist as the
storage location of the indices.

FULSEARCH This is the directory or directories that Hummingbird will search. There can
be more than one directory, and multiple directory entries must be separated
by semicolons, without spaces. The list must always include the 
Fulcrum\Fultext directory.

FULTEMP The directory that Hummingbird uses to store temporary data, normally the
directory pointed to by the TEMP environment variable. 

FTNPATH The address and name of the client connector. This is the SearchServer 
machine name and address to users. This is case sensitive, and should be 
entered in lowercase when required.
114 Siebel Search Administration Guide MidMarket Edition Version 7.5



Siebel Search Environmental Variables

Siebel Environmental Variables
■ FULTEMP: 
C:\SIEBEL70\search\ServerDataSrc\temp

■ FTNPATH: (empty)

Remote Search Server. If you configure your Siebel Server to connect to a remote 
Search Server searchserver with port number 2048, the following parameters will 
be set:

■ FULCREATE: (empty)

■ FULSEARCH:
C:\SIEBEL70\search\fulcrum\fultext

■ FULTEMP: 
C:\SIEBEL70\search\ServerDataSrc\temp

■ FTNPATH: 
searchserver/tcp2048

Typically, you will not need to set these variables, as Siebel Search code will set 
them at the run time.

Hummingbird Client Connector. If you configure a Hummingbird Client Connector, 
which is required to set up a remote Search Server, note the following example:

■ Client Connector: tcp2048

■ FULCREATE: 
C:\SIEBEL70\search\ServerDataSrc\index

■ FULSEARCH: 
C:\PROGRAM FILES\FULCRUM\FULTEXT;C:\SIEBEL70\search\ServerDataSrc\index

■ FULTEMP:
C:\SIEBEL70\search\ServerDataSrc\temp
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This section includes troubleshooting information for installation, configuration, 
and administration of Siebel Search.
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Siebel Search Version 7.5 Setup Troubleshooting
This appendix lists potential problems associated with setup and implementation of 
Siebel Search. Table 25 lists potential symptoms along with a cross reference to 
areas in the appendix you should refer to. 

Table 25. Hummingbird Setup Troubleshooting Key

For These Symptoms Refer to These Questions

Only Find objects show up (in Search Center). Error 
message says Search is not set up in Customer Search

(1), (2), (3), (4), (6)

Error when going to the Search Administration 
screens: “The Fulcrum library can not be loaded. The 
Fulcrum installation may not be set up correctly. 
Please contact your system administrator.”

(1), (2), (4)

Index function is unavailable in the Search 
Administration view

(5)

Error when indexing (4), (7), (8), (9)

Zero records when indexing (10), (11)

Expected records not found (11), (12),(13), (14)

Error when searching search center (Fulcrum error) (2), (4), (15), (16)
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Hummingbird Installation

1 Question. Is Hummingbird Version 5.0 installed?

Requirement. Hummingbird is required to be installed on the Search server to 
allow Siebel Search. See Chapter 4, “Installing Siebel Search Under Windows” 
for instructions on installing Siebel Search.

How to check. In Windows, go to Programs from the Start menu and look for a 
program group called Fulcrum. Open up ExecSQL. On the splashscreen, you 
should see that the version is 5.0. 

2 Question. Is more than one version of Hummingbird installed?

Requirement. If an older version of Fulcrum is still installed or incompletely 
removed, then Siebel Search may not work. The older version must be 
completely uninstalled. See “Upgrade Notes for Windows Users” on page 40 for 
information about removing older versions of Fulcrum from the machine.

How to check. Go to the add/remove programs icon in Windows Settings > 
Control Panel. Fulcrum 3.7e and earlier versions have multiple programs 
installed. In addition, check the path variables for the machine and make sure 
that the Fulcrum reference only points to the current version of Hummingbird 
5.0.

Basic Setup

3 Question. Have you ever built or copied indices? 

Requirement. In order to use Siebel Search, Search indices must be built. For 
testing purposes, indices already built in another setup (for example, in the 
sample database) can be copied into the correct index location. See Chapter 4, 
“Installing Siebel Search Under Windows” and Chapter 6, “Administration of 
Siebel Search” for instructions on installing Hummingbird and creating indices 
respectively.

How to check. Search indices are always located in the same location. You can go 
to the \Siebel_Root\search\sample\index directory and you should see a set of 
around six files for each index that will have labels that start with “FUL” 
followed by the index name. Some of the file sizes may be 1 KB, but most will 
be larger.
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4 Question. Did you install Hummingbird before installing the Siebel Server?

Requirement. It is recommended that Hummingbird 5.0 be installed before the 
Siebel Server in order to minimize configuration. If you installed Hummingbird 
after you installed Siebel Server, you will need to modify some search 
parameters. 

How to check. See “Siebel Search Parameters” on page 45 for information on 
viewing and modifying the Search Parameters. These modifications are done 
through the server administration screens for a server, and through the .cfg file 
for sample searching.

5 Question. Are there multiple application servers pointing to a single Search 
Server?

Requirement. Search administration must be done by pointing directly to the 
application server residing with the Search Server itself. If you point to another 
application server, then you will not be able to administer Siebel Search.

NOTE: When using Resonate, be careful to connect to the correct Siebel server.

6 Question. Did you create indices after opening up Search Center or after doing a 
search during the current session?

Requirement. When the Search Center is first opened in a server session or a 
search view is displayed in the customer applications, the list of available search 
indices information is cached for all users. This means that any new indices 
created during the current session will not show up in this session or in 
subsequent sessions. To refresh the cache it is important to connect to each 
Siebel server directly, go to the Search Administration - Search Indices view and 
choose the Reload Categories menu item from the top applet. This will reload 
the new list of available indices for that server. The servers do not have to be 
restarted. Simply opening a new session will show the new list of search 
categories.

How to check. After restarting the server and clients, you will now see the 
indices.
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7 Question. Is your stop file setting pointing to the correct Hummingbird location?

Requirement. When indexing, a file called a stop file is used to eliminate 
unnecessary words. The location of this stop file is in 
\Fulcrum_Root\fultext\fultext.stp. This value must be set for the stop file 
location in the Search Index Settings view.

How to check. Go to the Search administration screens and the Search Index 
Settings view. There is a setting called Stop File which should point to the actual 
location of the stop file. For mobile client administration, copy the stop file to 
the index folder, and change the setting to the name of the stop file. 

8 Question. Are you setting up SearchServer under Windows on an Oracle 
database? 

Requirement. There is one additional step required for setting up search under an 
Oracle database. See “Additional Steps for Oracle Database Users Under 
Windows” on page 44 for details on setting up the ODBC data source. 

9 Question. Is the file system set up correctly?

Requirement. Building an index is dependent on the file system. Problems with 
the file system may cause errors when indexing.

How to check. Go to the Resolution Documents Administration view and try to 
open files and save new files to the application. You should not receive any 
errors.

10 Question. Are you trying to index off of the sample database?

Requirement. Only data in databases connected to a server by ODBC connectors 
can be used to build new indices. If you try to index while pointing to the sample 
database, you will create new indices with zero records in them.

How to check. When you are indexing from the search administration view, you 
will see a result of 0 records indexed. 
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Visibility

11 Question. Are the records you are indexing related to categories?

Requirement. Most search categories are set up to apply access catalog category 
visibility. If a record is found when indexing which is not associated to any 
category, then it will not be indexed. 

NOTE: Catalog categories need to be active and should have valid Start and End 
dates.

How to check. Go to the Administration Screen for the record being indexed (for 
example, Solution Administration) and check whether the records are associated 
with categories. If not, then the records must be associated with categories and 
then the index must be recreated or refreshed, or the search category must be 
modified to remove the access group visibility. See “Indexing Fields to Enforce 
Catalog Category Visibility” on page 63 for information on modifying visibility 
for a search index.

12 Question. Do you get zero records for one search category while other search 
categories return records?

Requirement. If no records show up for any index, then this may be because none 
of the indices contain any records. 

You may also have incorrect Advanced Search Settings. The settings to look for 
are Character Set and Term Generator. 

■ In Search Server 5.0, the character set should always be UTF8. 

■ If a linguistic filter is specified in the Term Generator property, make sure that 
the SPELL option is not specified. This has been deprecated in Search Server 
5.0 but was supported in 4.0. For example, word!ftelp/inflect/spell should be 
changed to just word!ftelp/inflect

How to check. Choose a search category and search for asterisk (*). You should 
get a full list of all records available in the index. You can also check in the search 
administration view whether each search index contains any records.
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13 Question. Is the Search Filter spec eliminating the records you expect to see?

Requirements. Search categories often have search specs applied on them as part 
of their Siebel Tools definition. This search spec will filter out records from 
results if they do not meet the required search spec.

How to check. In Siebel Tools, go to the Search Engine > Search Definition > 
Search Definition Category to see if there is a search spec. Compare this spec to 
the records you were expecting to see as search results.

14 Question. Why is index generation taking so long?

Requirements. Make sure that the index setting Log Control is not set. It is 
important that the level of logging should be only what is required for problem 
solving (remove this setting if no problems are encountered). This is because 
excessive logging reduces database text reader performance and may consume 
considerable disk space.

How to check. The .dil files generated for each index operation will be small (a 
few Kb).

15 Question. Why do search categories not show up when connecting remotely to a 
search server using a client connector?

Requirement. It is important to make sure that both the Hummingbird Connect 
Manager and Hummingbird Connector services are started. Also the account 
used to logon to the service must be a valid user/system account with the proper 
rights set. It's also important to make sure that the directories specified in the 
FULTEMP and FULCREATE variables in the client connector have read/write 
access. Search Server writes to these directories. Please refer to the Planning and 
Installation Guide of the Search Server Documentation for more details.

How to check. To verify that the server and client are configured properly, run 
ExecSQL and execute the script tbls.fte. This file comes with the Search Server 
installation. This script will list each table found on the local node by path, 
followed by the names of each remote node and their respective tables. 

NOTE: ExecSQL is a command line utility that you can use to execute SearchSQL 
statements and run scripts. Please refer to the Data Preparation and 
Administration Guide of the Search Server documentation for more information 
on using this utility.
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16 Question. When can I start and stop the client connector?

Requirements. By starting a client server, you enable communication between the 
client and the server. Stopping a client connection not only prevents a client 
connector from listening for new client connections, it also stops all currently 
connected clients. You have to stop the client connector prior to making 
modifications to it. For example, the client connector must not be running if you 
want to make changes to the connection security option of the connector or 
Startup type of the connector. 

To start a client connector 

■ On the Start menu, click Programs/Hummingbird/Search Server 5.0/
Hummingbird Connector Manager. 

■ In the Hummingbird Server Service Setup dialog box, click Start. 

To stop a client connector 

■ In the Hummingbird Server Service Setup dialog box, click Stop. 

■ You will be prompted to confirm this action.

■ Click OK. 

Using the Verbose Parameter
By default, there is very little information added to the index log following a 
VALIDATE INDEX. If you had problems and want to track them more thoroughly in 
the log file, you should use the VERBOSE parameter with the VALIDATE INDEX 
request in the .DID file and run manually using ExecSql.

Example:

VALIDATE INDEX FUL_SOLN VERBOSE VALIDATE TABLE;
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This section lists syntax requirements for filtering Search within Siebel Search 7.5.
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Filter Search Spec Syntax
This section describes the supported syntax elements for filter search specifications. 
The filter search spec is parsed based on the validation rules determined by 
SearchServer 5.0 for searching on unstructured text. For more information, see the 
Hummingbird Search SQL Reference Guide of the Search Server 5.0. 

Precedence
Precedence refers to the order in which the SearchServer evaluates the various 
search operators within the filter search query specification. Table 26 shows the 
levels of precedence. SearchServer follows the standard rules of precedence. 
Expressions within parentheses are evaluated first.

Using parentheses can alter the order of precedence within an expression.

Siebel Applications evaluate the expression within the parentheses first, before 
evaluating the expression outside.

Table 26. Level of Precedence

Level Operator

1 ()

2 NOT

3 AND

4 OR
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Comparison Operators
Table 27 describes the purpose of each comparison operator and gives an example 
of how it is used.

NOTE: The last 4 operators are used only for Date fields.

Logical Operators
Table 28 explains what a value of TRUE or FALSE means for each logical operator.

Table 27. Comparison Operators

Operator Purpose Example

= Equality Text [Publish External] = "Y"

<> Inequality text [Role] <> LookupValue ("ROLE_TYPE", 
"Manager")

> Greater than [Start Date] > Today()

< Less than [End Date] < Today() + 4

>= Greater than or equal to [Start Date] >= Today()

<= Less than or equal to [End Date] <= Today() - 4

Table 28. Logical Operators

Operator Returns TRUE Returns FALSE

AND If all component 
conditions evaluate to 
TRUE

If any component condition evaluates to 
FALSE

OR If any component 
condition evaluates to 
TRUE 

If all component conditions evaluate to 
FALSE
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Pattern Matching with LIKE and NOT LIKE

NOTE: The Search Engine Table property for View and Applet must be based on the 
same table as the index. For example, if the search index is based on S_EVT_ACT, 
then the view should be based on action and the applet should be based on action. 
The LIKE operator is used in character string comparisons with pattern matching.

The syntax is as follows:

■ char1 LIKE char2

where char1 is the value to be compared with the pattern and char2 is the 
pattern to which char1 is compared. The NOT logical operator can be used in 
conjunction with LIKE to exclude patterns.

The syntax including the NOT logical operator is:

■ char1 NOT LIKE char2

or

■ NOT (char1 LIKE char2)

While the equal ( = ) operator does exact matching, the LIKE operator matches a 
portion of one character value to another. Patterns can use special characters to 
denote different characters. These characters are given in Table 29.

Table 29. Pattern Matching Using Special Characters

Character Purpose Example

* Zero or more characters [Sales Type] LIKE Sales* would return all 
records whose [Sales Type] value starts with 
the characters Sales, as in Sales-Brochure, 
Sales-Presentation, and so on.

? One character [Sales Type] NOT LIKE Sale? would return all 
records whose [Sales Type] value was 5 
characters long and did not start with the 
letters Sales. Records with Sales would not.
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Functions in Calculation Expressions
Functions that can be used in the filter search specification are listed in Table 30. 

Table 30. Functions that May be Used in Filter Search Specs

Character Purpose Example

GetProfileAttr ("[Attribute]") String Returns the value stored in the profile attribute 
if that attribute has been defined. Used in 
personalization to retrieve values of attributes in 
a user profile and to pass information from a 
script to the UI. Set a session-specific 
personalization attribute equal to the value of 
the shared global and reference the 
personalization attribute in a calculated field.

NOTE: For an undefined attribute or for an 
attribute that has not been set up, GetProfileAttr 
returns NULL. Search Server does not support 
NULL values in the query. 

LookupValue (type, lang_ind_code) String Finds a row in S_LST_OF_VAL where the TYPE 
column matches the type argument, the CODE 
column matches the lang_ind_code argument, 
and the LANG_ID column matches the language 
code of the currently active language. Returns 
the display value (the VAL column) for the row. 
This function is used to obtain the translation of 
the specified untranslated value in the specified 
LOV into the currently active language.

Today Date Today’s date (for example, 6/30/02).

GetValidCatalogCategories() String Returns a list of valid catalog categories for the 
current logged in user. 
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Filter Search Specification
Assigning a search expression to an object definition's Search Specification property 
is similar to the predefined query's expression; however, identifying the business 
component and specifying the reserved word Search is not required.

NOTE: The Search Specification expression must be on one line. If more than one 
line is used the search spec may not get processed correctly.

Examples of the Filter Search Specification
■ [Close Date] > "04/15/95"

■ [Sales Tool Type] LIKE "Cal*"

■ [Start Date] >= Today () AND [End Date] <= Today() + 100

■ [Solution Type] = LookupValue ("SOLUTION_TYPE", "Solution") AND 
([Publish External] = "Y"

■ [PriceListId]=GetProfileAttr("DefaultPriceListId")

NOTE: For date formats in filter Search Specification, use the business component 
format. To reference a field value, you must use [Filter Field Name]. Also, string 
constants must be enclosed in double quotation marks ("string").

In the preceding examples, the fields declared must exist within the designated 
search filter field object definition. Some special fields that can be used are the Id 
field.

Filter Searches From the User Interface
The syntax is slightly different for searches on filter fields done from the user 
interface. Only single values are accepted and logical operators are not supported.

Example 
■ > '12/12/01'

■ "Sales*"
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Filter Search Specification Syntax in Backus-Naur Format
Filter searching can be performed through the user interface controls (exposed 
through special filter applet), or specified in the filter search Specification property 
of the Search Definition category. The syntax is slightly different when done 
through the user interface, but in all cases the syntax is simple BNF (Backus-Naur 
Format).

Examples
Search Statement

■ : condition

■ : expression

condition

■ : comparison

■ : condition [AND | OR] condition

comparison

■ : expression [= | < | > | <= | >= | [NOT] LIKE] expression

expression

■ : constant

■ : identifier

■ : function

constant

■ : string (double quoted)

■ : date (double quoted)"MM/DD/YY" (separator must be "/")

identifier

■ : [filter field name]

NOTE: Searches on filter fields from the UI do not support the logical operators AND 
/ OR.
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A
access control visibility

about 35
indexing fields to enforce 63

administration
See also search execution settings
cached list of categories, resetting 101
Fulcrum stop file setting, about 97
Fulcrum stop file setting, changing under 

Windows 99
index settings, about and creating 95
mobile Web client, synchronizing indexes 

on 105
normalization setting, about 95
normalization setting, creating 95
search index, indexing 101
search indexes, refreshing 102
search indexes, refreshing all 

indexes 102
search indexes, working with 101
Siebel Search, about 31
transaction table settings, changing 96
transaction table settings, table of 96

Advanced Search
link, about using 18

application find objects, table of 72
attachments

indexing 62
rules and assumptions 62

B
binocular icon, using to open Search 

Center 18
Boolean operators

basic search, about 14

C
check document status setting, 

administrating 106
configuring Siebel Search, about 31
connectives, table of connectives and search 

operators 20
customer applications, accessing Siebel 

Search and performing search 18

F
file attachments

indexing 62
rules and assumptions 62

filter fields
creating, procedure 87

filter visibility for search, about 35
Find Field Locale object properties, table 

of 76
Find Field object

properties, table of 73
rules and assumptions 74

Find Locale object properties, table of 76
Find objects

See also Siebel Tools
application find objects, table of 72
described 32
Find Field Locale object properties, table 

of 76
Find Field object properties, rules and 

assumptions 74
Find Field object properties, table of 73
Find Locale object properties, table 

of 76
Find Pick View object properties, table 

of 77
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Find view object, about 75
Find view object, properties 75
properties, table of 71
Siebel Tools object and their 

relationships, diagram 70
Siebel Tools object for find, about 70

Find operation, differences between Search 
and Find 33

Find view objects
about 75
properties 75

Fulcrum
basic setup troubleshooting 119
Client Connector, setting example 115
installation troubleshooting 119
setup troubleshooting key, table 118
stop file setting, about 97
stop file setting, changing under 

Windows 99
visibility, troubleshooting 122

Fulcrum SearchServer
See also Fulcrum
hardware requirements 30
Windows, before installing on 38
Windows, creating a client connector 48
Windows, installing Fulcrum 4.0 42
Windows, removing Fulcrum 40

H
help

Fulcrum basic setup 
troubleshooting 119

Fulcrum installation 
troubleshooting 119

Fulcrum setup troubleshooting key, 
table 118

Fulcrum visibility, troubleshooting 122

I
Index Field Map objects

defining 60
properties, table of 61

index settings
See also indexes
creating 95
Fulcrum stop file setting, about 97
Fulcrum stop file setting, changing under 

Windows 99
normalization setting, about 95
normalization setting, creating 95
transaction table setting, changing 96
transaction table settings, table of 96

indexes
See also index settings
cache list of categories, resetting 101
mobile Web client, synchronizing indexes 

on 105
refreshing all indexes 102
refreshing an index 102
search index, indexing 101
working with, about 101

installation
See also windows, installing on
installing, process of 28
troubleshooting Fulcrum install 119

M
max exec time setting, administering 108
max search rows setting, 

administering 109
mobile Web clients

Fulcrum software, about 28
indices, synchronizing on 105
setup, process overview 27
Windows, setting up 51

multi organizational access control, 
about 35

multiple term searches, about 15

N
normalization setting

about 95
creating 95

NOT operator, about using to limit query 
results 21
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O
operators

connective and search operators, table 
of 20

NOT operator, about using to limit query 
results 21

Oracle database
Windows Siebel Server, setting up ODBC 

data source 44
organizational visibility

indexing fields to enforce 64
view, about 34

P
parameters

Siebel Search, about 45
Siebel Search, table of 46
Siebel Search, viewing or modifying 46

phase searches, about 15
pick views

creating 80
creating, about 79
properties, table of 80

Position visibility view, about 34, 35
preinstallation checklist

Windows install 39
preview views

creating 81
creating, about 81

Q
queries, table of search query examples 22

R
records, about determining display of 33
Remote Search Server, setting example 115
remote searching

Siebel Server, setting up for 48
Result fields

custom fields, about creating 83
custom fields, creating (procedure) 84
custom fields, properties (table) 83
new fields, adding 82
new fields, rules and assumptions 82

retrieval types. See searching

S
Search box, about using 18
search categories

See also search indexes
creating 67
new search definition, associating 

with 78
properties, table of 68
rules and assumptions 67

Search Center, described 18
Search Definition object, about and rule and 

assumptions 69
search engine

See also search indexes; Siebel Tools; 
Search Engine Results fields

Search Engine object, properties 56
Search Result Field object, about 56
Search Result Field object, properties 57
Search Result Field object, rules and 

assumptions 57
Search Engine Results fields

See also search engine
custom fields, about creating 83
custom fields, creating (procedure) 84
custom fields, properties (table) 83
new field, adding 82
new field, rules and assumptions 82

search execution settings
See also administration; search execution 

settings, advanced
about and diagram 106
check document status setting, 

administrating 106
max exec time setting, 

administering 108
max search rows setting, 

administering 109
search term separator setting, 

administering 111
Server Report Time setting, 

administering 110
Search Index object, rules and 

assumptions 58
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search indexes
See also search engine; search categories; 

Siebel Tools
about 31
access control visibility, indexing fields to 

enforce 63
cached list of categories, resetting 101
file attachments, indexing 62
file attachments, rules and 

assumptions 62
index, refreshing 102
indexes, refreshing all 102
indexing 101
mobile Web client, synchronizing indexes 

on 105
organizational visibility, indexing fields to 

enforce 64
properties, table of 59
Search Index object, rules and 

assumptions 58
search tables, defining Index Field 

Maps 60
search tables, Index Field Maps, 

properties (table) 61
search tables, properties (table of) 60
search tables, rules and assumptions 59
working with, about 101

Search object, described 32
search operations, advanced

filter field, creating (procedure) 87
pick views, about creating 79
pick views, creating 80
pick views, properties (table) 80
preview views, about creating 81
preview views, creating 81
search categories, associating to new 

search definition 78
Search Result Field object

about 56
properties, table of 57
rules and assumptions 57

search server
configuration, setting example 114

search tables
Index Field Map, defining 60
Index Field Map, properties (table) 61
properties, table of 60
rules and assumptions 59

search term separator setting, 
administering 111

searching
Find operation, difference between 33
operators and connectives for Siebel 

Search 20
queries, search query examples 

(table) 22
retrieval type, basic search 14
search term separator, setting 

default 111
SearchServer API function, setting 110
server

multiple sever, process setup 
overview 27

setup process overview 26
server report time setting, 

administering 110
setup

process overview and architecture 
diagram 26

setting up, process of 28
Siebel Search

about 13
common end-user tasks, list of 19
configuring and administering, about 31
customer applications, accessing and 

performing search 18
operators and connectives, table of 20
parameters, about 45
parameters, table of 46
parameters, viewing or modifying 46
predefined search specifications. 

about 35
Siebel Server

See also Oracle database
remote searching, setting up for 48
Windows, configuring under 43
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Siebel Tools
See also Find objects; search engine; 

search indexes
Find object, described 32
preconfiguration checklist 54
Search object, described 32
search objects (diagram) 55

special character searches, about 16
stop file setting, about 97

T
table, setting maximum number of rows 

included 109
Team visibility view, about 34
timestamps, setting to determine if 

checked 106
transaction table settings

changing 96
table of 96

troubleshooting
Fulcrum installation 119
Fulcrum setup troubleshooting key, 

table 118
Fulcrum visibility 122
Fulcrum, basic setup 119

V
visibility

access control, indexing fields to 
enforce 63

defined 33
filter visibility for search 35
Find operations, controls 34
organizational visibility, indexing fields to 

enforce 64
Search, controls 35
troubleshooting 122

W
Web client, process setup overview 27
wildcard searches, about 16
Windows

Fulcrum stop file location, changing 99

Windows, installing on
Fulcrum SearchServer 4.0, installing 42
Fulcrum SearchServer, before 

installing 38
mobile Web client, setting up 51
Oracle database. setting up ODBC data 

source 44
preinstallation checklist 39
remote search, setting up Siebel Server 

for 48
Siebel Server, configuring 43
upgrade notes, removing Fulcrum 40
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